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I. РАБОЧАЯ ПРОГРАММА ДИСЦИПЛИНЫ 

1. ЦЕЛИ И  ЗАДАЧИ ОСВОЕНИЯ ДИСЦИПЛИНЫ 
Цель дисциплины: ознакомление студентов с современными информационными 

технологиями, техническими средствами и программным обеспечением, необходимыми для 
жизни и деятельности в информационном обществе; подготовка к практическому использо-
ванию средств новых информационных технологий (НИТ) в образовании, при решении при-
кладных задач в различных предметных областях и применению мультимедиа технологий в 
образовательной и научной деятельности. 

Задачи дисциплины: 

− определение понятийного аппарата информатики в области компьютерных техно-
логий обработки и анализа информационных источников; 

− выявление сущности технологических процессов компьютерных технологий рабо-
ты с информационными источниками; 

− анализ и изучение программ обработки электронных источников; 

− знакомство с некоторыми специальными компьютерными технологиями, предна-
значенными для работы с информацией. 

2. МЕСТО ДИСЦИПЛИНЫ В СТРУКТУРЕ ООП ВПО 
Предлагаемая дисциплина относится к вариативной части естественнонаучного цикла 

ООП, индекс дисциплины – ЕН.В.1. 
Для успешного освоения данной дисциплины необходимы базовые знания курса 

«Информатика» в объеме средней общеобразовательной школы; «Информатика», изучаемая 
в вузе. Знания, полученные при изучении дисциплины «Новые информационные технологии 
в учебном процессе» будут использованы при изучении таких дисциплин, как «Социальное 
прогнозирование и проектирование».  

Дисциплина занимает важное место в программе подготовки специалистов, так как 
обеспечивает базовую подготовку студентов в области использования средств вычислитель-
ной техники: для всех курсов, использующих автоматизированные методы анализа, расчетов 
и компьютерного оформления курсовых и дипломных проектов.  

3. ПОСЛЕ ИЗУЧЕНИЯ ДИСЦИПЛИНЫ СТУДЕНТ ДОЛЖЕН:  
Знать: 
− принципы хранения, обработки, распространения и представления информации;  
− структуру и возможности современных персональных ЭВМ и компьютерных сетей;  
− возможности применения компьютерной техники в учебном процессе; принципы 

построения обучающих и контролирующих программ разного уровня сложности; 
− способы обработки и анализа информационных источников средствами информа-

ционных технологий;  
− существующие программы обработки и анализа информации.   
Уметь: 
− выбирать технологию, программное обеспечение и формат для обработки и анализа 

информации и информационных источников; 
− уметь применять пакеты прикладных программ и инструментальные средства для 

подготовки учебно-методических материалов; 
− решать исследовательские задачи с помощью информационных технологий; 
Иметь представление о: 
− тенденциях развития современных средств вычислительной техники и информаци-

онных технологий.  
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4.СТРУКТУРА И СОДЕРЖАНИЕ ДИСЦИПЛИНЫ 
Общая трудоемкость дисциплины составляет 100 часов. 

Виды учебной 
работы, включая 

самостоятель-
ную работу сту-
дентов и трудо-
емкость (в ча-

сах) № 
п/п 

Раздел дисциплины 
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Формы текущего кон-
троля успеваемости (по 

неделям семестра) 
Форма промежуточной 

аттестации 
(по семестрам) 

1 
Информационные процессы 
и технологии 

7 1 2  4 тест 

2 
Архитектура и структура 
ЭВМ 7 2 2  6 тест 

3 
Классификация программ-
ного обеспечения ПК 

7 3, 4 4  10 тест 

4 
Основы редактирования 
текстовых документов 7 5 2 4 6 тест  

5 Графические редакторы 7 6 2 2 4 тест 
6 Электронные таблицы 7 7 2 2 4 тест 

7 
Технология проектирова-
ния компьютерных тестов 

7 8 2 2 6 тест 

8 
Информационные и теле-
коммуникационные ком-
пьютерные сети 

7 9-12 8 4 10 тест 

9 
Компьютерные вирусы 

7 
13, 
14 

4  8 тест 

 ИТОГО   28 14 58 зачет 
5. СОДЕРЖАНИЕ РАЗДЕЛОВ И ТЕМ  ДИСЦИПЛИНЫ 
5.1. Лекции 

№ 
п/п 

Наименование 
темы 

Содержание темы 

1 

Информацион-
ные процессы и 
технологии 

Информационная сущность процесса обучения. Внедрение компью-
терной техники в учебный процесс. Информационные процессы (по-
иск, сбор и хранение, передача,  обработка, использование, защита). 
Информационная  технология, новая информационная технология. 
Этапы развития информационных технологий. 

2 

Архитектура и 
структура ЭВМ 

Понятие архитектуры ЭВМ. Классификация ЭВМ. Основные харак-
теристики вычислительной техники (быстродействие, производи-
тельность, тактовая частота, разрядность машины и кодовых шин 
интерфейса, емкость,  точность вычислений, система команд, надеж-
ность) 

3 
Классификация 
программного 
обеспечения ПК 

Классификация программ для компьютера (прикладные программы, 
системные программы, инструментальные компьютерные системы) 
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4 

Основы редак-
тирования тек-
стовых доку-
ментов 

Текстовые редакторы и процессоры. Текстовые файлы и документы. 
Формат текстового файла. Классификация текстовых редакторов и 
процессоров. Буфер обмена. Принцип OLE-обмена. Внедрение и свя-
зывание объектов. Обработка связей. Стандартные функции тексто-
вого редактора Word.. Форматирование. Разметка страницы. Тексто-
обработка и графика: создание и импорт рисунков, графический ин-
струментарий текстового редактора, создание и редактирование 
внешних графических объектов, внедрение графических объектов в 
текст. Работа с таблицами, формирование таблиц. Работа со стилями.  

5 

Графические 
редакторы 

Промежуточный "карман". Принцип OLE. Внедрение и связывание 
объектов. Обработка связей. Создание и импорт рисунков. Графиче-
ские редакторы. Векторные и растровые изображения. Программа 
PhotoShop. Векторная графика. Программа Corel Draw. Растровая 
графика. Цветокоррекция. Цветовые координаты. Цветовые схемы и 
режимы. Разрешение и разрешающая способность. Глубина пикселя. 
Форматы графических файлов. 

6 

Электронные 
таблицы 

Первичная и производная информация. Табличные процессоры. На-
значение табличных процессоров. История развития электронных 
таблиц. Excel и его основные возможности. Адресация ячеек, отно-
сительные и абсолютные адреса. Ввод данных в ячейку таблицы, 
формат ячейки. Табличные вычисления. Расчетные операции. Работа 
с формулами и функциями. Арифметические и логические функции. 
Ошибки при обработке электронных таблиц. 

7 

Технология 
проектирования 
компьютерных 
тестов 

Компьютерные тесты. Типы компьютерных тестов. Этапы разработ-
ки компьютерных тестов. Инструментальные тестовые оболочки 

8 

Информацион-
ные и телеком-
муникационные 
компьютерные 
сети 

Понятие компьютерной сети. Устройства сети: сервер, рабочая стан-
ция, коммуникационные узлы. Характеристики сети. Классификация 
сетей по территориальному признаку: LAN, MAN, WAN сети. Эта-
лонная модель OSI. Топология компьютерных сетей. Стек протоко-
лов TCP/IP. Программное обеспечение компьютерных сетей: одно-
ранговые и с выделенным сервером. Сетевые ОС. Понятие Интернет. 
История создания сети Интернет. Современная структура сети Ин-
тернет. Адресация в сети Интернет: IP, URL. Службы сети Интернет. 
Поиск информации в Интернет. Основы защиты информации и све-
дений, составляющих государственную тайну: угрозы информации в 
сети, основные аспекты безопасности. Методы защиты информации: 
криптография, электронная подпись, аутентификация, сертификация 
Web-узлов. 

9 

Компьютерные 
вирусы 

Определение вируса. История возникновения и развития вирусов. 
Классификация компьютерных вирусов. Антивирусные программы, 
их виды и использование. Антивирусные комплексы. Обновление 
антивирусных программ. 

5.2. Практические занятия 

Наименование темы Содержание темы 
Создание текстовых доку-
ментов 

Создание текстового документа. Форматирование текстов. Соз-
дание таблиц и схем. Списки, стили, оглавления. Создание и 
редактирование формул. 

Обработка графического Работа с цифровой фотокамерой, получение изображений. Об-
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изображения работка фотографий на компьютере с помощью графических 
редакторов. 

Электронные таблицы Создание простейшей таблицы. Ввод и редактирование данных. 
Формат данных. Адресация. Вычисления в таблицах. Сорти-
ровка данных и форматирование таблиц. Графический анализ 
данных. 

Технология проектирова-
ния компьютерных тестов 

Создание компьютерных тестов с использованием различных 
программ 

Работа с электронной по-
чтой 

Создание собственной учетной записи в Outlook. Написание и 
отправка писем (с оформлением, с вложением). Подписка на 
рассылки (ежедневная, еженедельная, ежемесячная). Создание 
адресной книги. Настройка правил для сообщений. 

Браузеры. Работа с про-
граммой IRC 

Создание своего пользователя программы IRC. Обмен сообще-
ниями с другими пользователями в группе. 

6. САМОСТОЯТЕЛЬНАЯ РАБОТА 

№ п/п № раздела (те-
мы) дисциплины 

Форма (вид) самостоятельной работы Трудоемкость в ча-
сах 

1 1 Подготовка к тесту 4 
2 2 Подготовка к тесту 6 
3 3 Эссе. Реферат.  10 
4 4 Реферат. Подготовка к практическому 

занятию с использованием обучающего 
теста.  

6 

5 5 Подготовка к практическому занятию с 
использованием обучающего теста.  

4 

6 6 Подготовка к практическому занятию с 
использованием обучающего теста. 

4 

7 7 Подготовка к практическому занятию с 
использованием обучающего теста.  

6 

8 8 Подготовка к практическому занятию с 
использованием обучающего теста.  

10 

9 9 Подготовка к тесту 8 

7. ОБРАЗОВАТЕЛЬНЫЕ ТЕХНОЛОГИИ И ФОРМЫ 
Образовательный процесс по дисциплине строится на основе комбинации следующих 

образовательных технологий.  
Интегральную модель образовательного процесса по дисциплине формируют техно-

логии методологического уровня: модульно-рейтинговое обучение, технология поэтапного 
формирования умственных действий, технология развивающего обучения, элементы техно-
логии развития критического мышления.  

Реализация данной модели предполагает использование следующих технологий стра-
тегического уровня (задающих организационные формы взаимодействия субъектов образо-
вательного процесса), осуществляемых с использованием определенных тактических проце-
дур: 

– практические (углубление знаний, полученных на теоретических занятиях, решение 
задач) (14 ч); 

– тренинговые (формирование определенных умений и навыков, формирование алго-
ритмического мышления) (тема 4 – 3 ч, тема 5 – 4 ч, тема 6, 9 – 4 ч); 

– активизации познавательной деятельности (приемы технологии развития критиче-
ского мышления через чтение и письмо, работа с литературой, подготовка презентаций по 
темам домашних работ) (тема 1 – 4 ч, тема 2 – 4 ч, тема 3 – 4 ч); 
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– самоуправления (самостоятельная работа студентов, самостоятельное изучение ма-
териала) (тема 2 – 3 ч, тема 7 – 5 ч, тема 8 – 4 ч).  

Рекомендуется использование информационных технологий при организации коммуни-
кации со студентами для представления информации, выдачи рекомендаций и консультирования 
по оперативным вопросам (электронная почта), использование мультимедиа-средств при прове-
дении лекционных и лабораторных занятий. 

8. ОЦЕНОЧНЫЕ СРЕДСТВА ДЛЯ ТЕКУЩЕГО КОНТРОЛЯ УСПЕВАЕМОСТИ, 
ПРОМЕЖУТОЧНОЙ АТТЕСТАЦИИ ПО ИТОГАМ ОСВОЕНИЯ ДИСЦИПЛИНЫ И 
УЧЕБНО-МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ САМОСТОЯТЕЛЬНОЙ РАБОТЫ СТУ-
ДЕНТОВ 

В качестве основных средств текущего контроля используется тестирование. В качестве 
дополнительной формы текущего контроля предлагаются аудиторные и внеаудиторные пись-
менные задания (контрольные работы). 

Для  самостоятельной работы используется учебно-методическое обеспечение на бумаж-
ных и электронных носителях. Тематика самостоятельной работы соответствует  содержанию 
разделов дисциплины и теме домашнего  задания. Освоение материала контролируется в процес-
се проведения лабораторных занятий.  

Контрольные вопросы и задания для проведения  текущего контроля выбираются из со-
держания разделов дисциплины. Выполнение домашнего задания обеспечивает непрерывный 
контроль за процессом освоения учебного материала каждого обучающегося, своевременное вы-
явление и устранение отставаний и ошибок. 

Промежуточная аттестация по итогам освоения дисциплины: зачет (7 семестр). 
 

Вопросы к зачету (7 семестр) 
1. История появления персональных компьютеров. Принципы фон Неймана.  
2. Принципы работы компьютера.  
3. Информационные процессы и технологии. Основные понятия и определения.  
4. Структура и архитектура ЭВМ. Аппаратная реализация компьютеров.  
5. Классификация современных ЭВМ. 
6. Основные характеристики вычислительной техники.  
7. Устройство памяти ЭВМ.  
8. Операционная система. Состав, назначение, загрузка.  
9. Файловая система организации данных. Логическая структура дисков, таблица раз-

мещения файлов FAT, NTFS.  
10. Программное обеспечение. Прикладные программы, системные программы, системы 

программирования. 
11. Компьютерные вирусы. Характеристика, классификация вирусов. 
12. Антивирусные программы.  
13. Принципы построения обучающих и контролирующих автоматизированных систем.  
14. Организация локальных сетей. Аппаратные и технические средства.  
15. Информационные и телекоммуникационные сети. 
16. Глобальные сети, Internet. Поиск, защита информации.  
17. Табличные процессоры на примере Excel. Ключевые понятия электронных таблиц.  
18. Технология обработки графической информации. 
19. Растровая и векторная графика. Графические редакторы.  
20. Компьютерные презентации.  

 
Вариант тестовых вопросов к зачету 

1. Объем текстовой информации в сообщении на 40 страницах (на странице 40 строк 
по 80 символов в строке) равен: 

a) 1 Мбайт;  
b) 120 Кбайт; 

c) 12 Кбайт; 
d) 125 Кбайт; 

e) 0,1 Мбайт. 

2. Данные – это: 
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a) отдельные факты, характеризующие объекты, процессы, явления; 
b) это выявленные закономерности в определенной предметной области; 
c) совокупность сведений, необходимых для организации хозяйственной деятельности 

предприятия; 
d) нет правильного ответа. 
3. Указать правильное перечисление свойств информации: 
a) объективность, насыщенность, достоверность, энтропия, доступность; 
b) объективность, полнота, достоверность, обоснованность, доступность; 
c) энтропия, актуальность, адекватность, насыщенность, доступность; 
d) энтропия, актуальность, полнота, адекватность, доступность; 
e) энтропия, полнота, достоверность, обоснованность, доступность. 
4. Даны утверждения: 1) компакт-диск является долговременной памятью; 2) сканер не 

является устройством ввода информации в компьютер; 3) принтер является устройством вы-
вода информации; 4) модем является устройством приема-передачи данных. Из них верными 
являются: 

a) 1, 2, 3; 
b) 2, 3; 

c) 1, 3, 4; 
d) 2; 

e) 3. 

5. Устройство обмена информацией с другими компьютерами по телефонным каналам 
– это: 

a) сканер; 
b) модем; 
c) дисковод; 

d) плоттер; 
e) стример. 

6. Каталог (папка) – это: 
a) раздел файловой системы, содержащий имена файлов и каталогов и сведения о их 

размещении на носителе информации; 
b) команда операционной системы, обеспечивающая доступ к данным; 
c) группа файлов, объединенных общим именем; 
d) устройство для хранения группы файлов и организации доступа к ним; 
e) путь, по которому операционная система определяет место файла. 
7. Кнопку панели инструментов нужно выбрать, чтобы вызвать диалоговое окно от-

крытия документа: 
a) 1; 
b) 4; 
c) 2; 
d) 3. 

8. Значение в ячейке С3 электронной таблицы после копирования ячейки C1 в ячейку 
С2 равно: 

a) 4; 
b) 3; 
c) 5; 

d) 7; 
e) –1. 

9. Указать, какое значение будет получено в ячейке В7: 
a) 0; 
b) 1; 
c) 2; 

d) 3; 
e) 4. 

10. Заражение компьютерным вирусом может проявляться в трех эффектах: 
a) замедление работы компьютера; 
b) изменение даты и времени модификации файлов; 
c) появление на экране непредусмотренных сообщений или изображений; 
d) мерцание ламп дневного света в помещении; 
e) вибрация монитора. 

Вариант тестовых заданий для промежуточного контроля 
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1. Архитектура компьютера – это: 
a) техническое описание деталей устройств компьютера; 
b) описание устройств для ввода-вывода информации; 
c) описание программного обеспечения для работы компьютера; 
d) описание устройства и принципов работы компьютера, достаточное для понимания 

пользователя.  
2. Первая аналитическая машина была изобретена: 

а) Ч. Беббидж;  b) В. Шиккард; c) Ж.Жаккард; d) Б. Паскаль. 
3. Плоттер – это устройства для:  
a) вывода любой информации на бумагу; 
b) для сканирования изображения с листа бумаги в компьютер;  
c) для ввода в компьютер информации; 
d) для вывода графической информации большего размера на бумагу. 
4. Скорость работы компьютера зависит от:  
a) тактовой частоты обработки информации в процессоре; 
b) наличия или отсутствия подключенного принтера;  
c) объема внешнего запоминающего устройства; 
d) объема обрабатываемой информации. 
5. Для чего предназначен жесткий диск (винчестер):  
a) для временного хранения информации; 
b) для длительного хранения и считывания информации, которая изменяется редко; 
c) для любого вида хранения информации (временного и длительного) и считывания 

информации; 
d) только для считывания информации. 
6. База данных – это:  
a) специальным образом организованная и хранящаяся на внешнем носителе совокупность 

взаимосвязанных данных о некотором объекте; 
b) совокупность программ для хранения и обработки больших массивов информации; 
c) интерфейс, поддерживающий наполнение и манипулирование данными; 
d) определенная совокупность информации. 
7. Компьютерная сеть – это: 
а) группа установленных рядом вычислительных машин, объединенных с помощью 

средств сопряжения и выполняющих единый информационно-вычислительный процесс; 
б) совокупность компьютеров и терминалов, соединенных с помощью каналов связи в 

единую систему, удовлетворяющую требованиям распределенной  обработки данных; 
в) совокупность сервера и рабочих станций, соединенных с помощью коаксиального или 

оптоволоконного кабеля. 
8. Абонент сети – это: 
а) аппаратура, выполняющая обработку данных на независимых компьютерах; 
б) объекты, генерирующие или потребляющие информацию; 
в) аппаратура для получения информации от сервера. 
9. Станция – это: 
а) средство сопряжения с компьютером; 
б) аппаратура для подключения к глобальной сети; 
в) аппаратура, передающая и принимающая информацию. 
10. Физическая передающая среда – это: 
а) линии связи, пространство для распространения сигналов, аппаратура передачи данных; 
б) мультиплексор передачи данных; 
в) витая пара проводов, коаксиальный кабель, оптоволоконный кабель. 
11. Для сопряжения ЭВМ с одним каналом связи используется: 
а) адаптер; б) концентратор; в) повторитель. 
9. УЧЕБНО-МЕТОДИЧЕСКОЕ И ИНФОРМАЦИОННОЕ ОБЕСПЕЧЕНИЕ ДИС-

ЦИПЛИНЫ 
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а) основная литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы и 

статистика, 2005, 2007, 2009. – 768 с.   
2. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
3. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – М.: Проспект, 

2009. – 272 с. 
4. Острейковский, В. А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Острейковский. – 

5-е изд., стер. – М.: Высш. шк., 2009. – 512 с. 
б) дополнительная литература: 
1. Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безручко. – 

М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
2. Корнеев И.К. Информационные технологии: учеб. / И.К. Корнеев, Г.Н. Ксандопуло, 

В.А. Машурцев. – М.: Проспект, 2007, 2009. – 222 с. 
3. Могилев А. В. Информатика: учеб. пособие: рек. Мин. обр. РФ / А.В. Могилев,  Е.К. 

Хеннер, Н.И. Пак; под ред. А.В. Могилева. – 2-е изд., стер. – М.: Академия, 2008. – 328 с.  
4. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. учеб. 

заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
5. Черников Б.В. Информационные технологии в вопросах и ответах: учеб. пособие: рек. 

УМО / Б.В. Черников. – М.: Финансы и статистика, 2005. – 320 с. 
6. Шапорев С.Д. Информатика. Теоретический курс и практические занятия: учеб.: рек. 

НМС / С.Д. Шапорев. – СПб.: БХВ-Петербург, 2008. – 469 с. 
в) перечень журналов: 
1. Информационные технологии. 
2. Информационные технологии и вычислительные системы. 
г) программное обеспечение и Интернет-ресурсы 

№ Наименование ресурса Краткая характеристика 
1 http://informatka.ru/ Содержит справочный материал по различным разделам 

информатики. 
2 http://www.iqlib.ru Интернет-библиотека образовательных изданий, в которой 

собраны электронные учебники, справочные и учебные по-
собия. Удобный поиск по ключевым словам отдельным те-
мам и отраслям знаний 

3 http://elibrary.ru Научная электронная библиотека журналов 
4 Windows Операционная система 
5 Microsoft Office   Пакет прикладных программ 
6 WinZip,WinRAR 3.2 Программа-архиватор 
7 PotoShop Программа обработки фотографий 

10. МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ ДИСЦИПЛИНЫ 
Класс ПЭВМ на базе процессора Intel Pentium. 
11. РЕЙТИНГ-ПЛАН ДИСЦИПЛИНЫ 

Тема Кол.баллов Виды работ 
Информационные процессы и технологии 5 тест 
Архитектура и структура ЭВМ 5 тест 
Классификация программного обеспечения ПК 5 тест 
Основы редактирования текстовых документов 8 практич.раб., тест 
Графические редакторы 8 практич.раб., тест 
Электронные таблицы 8 практич.раб., тест 
Технология проектирования компьютерных тестов 8 практич.раб., тест 
Информационные и телекоммуникационные компьютерные 
сети 

8 
практич.раб., тест 

Компьютерные вирусы 5 тест 
Зачет 40  
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Итого 100  
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II. КРАТКОЕ ИЗЛОЖЕНИЕ ПРОГРАММНОГО МАТЕРИАЛА 
Тема 1. Информационные процессы и технологии. 
План лекции: 
1. Информационная сущность процесса обучения. 
2.  Внедрение компьютерной техники в учебный процесс.  
3. Информационные процессы (поиск, сбор и хранение, передача,  обработка, ис-

пользование, защита).  
4. Информационная  технология, новая информационная технология.  
5. Этапы развития информационных технологий. 
Цель: формирование у обучаемых понимания роли и места информационных техно-

логий в профессиональной деятельности. 
Задачи: 
− формирование современной информационной культуры; 
− ознакомление с основными понятиями информационных технологий. 
Ключевые вопросы: 
1. Дать определение информация. Перечислить свойства информации. 
2. Понятия «сигнал» и данные. 
3. Дать определение информационные системы и информационные технологии. 
4. Передача и  обработка информации.  
Рекомендуемая литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2005, 2007. – 268 с.   
2. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
3. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
Тема 2. Архитектура и структура ЭВМ. 
План лекции: 
1. Понятие архитектуры ЭВМ.  
2. Классификация ЭВМ.  
3. Основные характеристики вычислительной техники (быстродействие, производи-

тельность, тактовая частота, разрядность машины и кодовых шин интерфейса, емкость,  точ-
ность вычислений, система команд, надежность). 

Цель: формирование устойчивых навыков использования аппаратных средств  вычис-
лительных систем в профессиональной деятельности. 

Задачи: 
− познакомить с историей развития вычислительной техники; 
− научить пользоваться техническими средствами реализации информационных про-

цессов; 
− привить навыки работы с периферийными устройствами. 
Ключевые вопросы: 
1. Перечислить этапы развития информатики. 
2. Классифицировать ЭВМ по истории создания и размерам. 
3. Развитие отечественной вычислительной техники. 
4. Классификация РС. 
5. Перечислить основные блоки ПК и их назначение. 
6. Запоминающие устройства персонального компьютера. 
7. Внешние запоминающие устройства. 
8. Накопители на гибких магнитных дисках (НГМД). 
9. Накопители на жестких магнитных дисках (НЖМД). 
10. Накопители на оптических дисках. 
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11. Устройства ввода информации. 
12. Устройства вывода информации. 
13. Средства связи и телекоммуникации. 
14. Устройства речевого ввода-вывода. 
Рекомендуемая литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2005, 2007. – 268 с.   
2. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
3. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
4. Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безруч-

ко. – М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
Тема 3. Классификация программного обеспечения ПК 
План лекции: 
1. Классификация программных средств.  
2. Прикладные программы. 
3. Системные программы. 
4. Инструментальные компьютерные системы. 
Цель: формирование у студентов теоретических знаний и практических навыков по при-

менению современных информационных технологий и систем. 
Задачи: 
− научить пользоваться программными средствами реализации информационных 

процессов; 
− сформировать навыки работы с программным обеспечением. 
Ключевые вопросы: 
1. Дать определение программного обеспечения, программы, программного продукта, 

интегрирование программного обеспечения. 
2. Классификация программного обеспечения по сфере использования. 
3. Операционная система, основная функция всех операционных систем. 
4. Определение сервисного программного обеспечения (программы-утилиты). 
5. Программы диагностики работоспособности компьютера и обслуживания дисков 

(служебные программы).  
6. Программы архивирования данных. 
7. Цели сжатия файлов. 
8. Антивирусные программы. Признаки появления вирусов. 
9. Какие антивирусные программы вы знаете? 
10. Прикладное программное обеспечение (определение) 
11. Графические редакторы. Типы графической графики. 
12. Перечислить характеристики растровых изображений, характеристики векторного 

изображения. 
13. Системы автоматического проектирования. 
14. Системы автоматизированного управления. 
15. Автоматизация научно-исследовательских работ. 
16. Программные средства мультимедиа. 
17. Системы видеомонтажа. 
18. Компьютерная обработка звука. Музыкальные редакторы. 
19. Обучающие программы. 
Рекомендуемая литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2005, 2007. – 268 с.   
2. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 
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Инфра-М, 2008. – 285 с. 
3. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
4. Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безруч-

ко. – М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
Тема 4. Основы редактирования текстовых документов 
План лекции: 
1. Текстовые редакторы и процессоры.  
2. Текстовые файлы и документы.  
3. Формат текстового файла.  
4. Классификация текстовых редакторов и процессоров.  
5. Буфер обмена.  
6. Принцип OLE-обмена.  
7. Внедрение и связывание объектов. Обработка связей.  
8. Стандартные функции текстового редактора Word. 
9. Форматирование. Разметка страницы.  
10. Текстообработка и графика: создание и импорт рисунков, графический инструмента-

рий текстового редактора, создание и редактирование внешних графических объектов, внедрение 
графических объектов в текст.  

11. Работа с таблицами, формирование таблиц.  
12. Работа со стилями.  
13. Классификация программных средств.  
Цель: формирование у студентов теоретических знаний и практических навыков работы с 

текстовыми документами. 
Задачи: 
− научить пользоваться программными средствами обработки текстовых документов; 
− сформировать навыки работы с текстовыми процессорами. 
Ключевые вопросы: 
1. Дать определение текстового редактора. 
2. Дать определение текстового процессора. 
3. Как установить поля страницы в документе? 
4. Каким образом вставить номера страниц в документ? 
5. Как расставить переносы в документе? 
6. Как создать в документе новый раздел? 
7. Что такое колонтитул? Каким образом он устанавливается? 
8. Как разбить текст на колонки, страницы, разделы? 
9. Как осуществить поиск и замену в документе? 
10. Как осуществить проверку орфографии в документе? 
11. Как форматируется текст в колонтитулах? 
12. Как добавить в текст надпись? 
13. Перечислить основные способы форматирования абзацев? 
14. Что такое Буквица и как ее установить? 
15. Перечислить основные инструменты панели Рисования и укажите их назначение. 
16. Как сформировать в документе Word оглавление? 
17. Как установить эффекты анимации? 
18. Как вставить объект WordArt? 
19. Какими способами можно создать список для выделенного текста? 
20. Можно ли изменить маркер в уже созданном списке? 
21. Как установить, или  снять обрамление и заливку абзацев? 
22. Для чего в документах Word используется элемент Надпись? 
23. Запуск редактора формул. 
24. Выход из редактора формул и последующее редактирование формулы. 
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25. Порядок создания математических формул. 
Рекомендуемая литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2005, 2007. – 268 с.   
2. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
3. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безручко. – 

М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
Тема 5. Графические редакторы 
План лекции: 
1. Промежуточный "карман".  
2. Принцип OLE.  
3. Внедрение и связывание объектов.  
4. Обработка связей.  
5. Создание и импорт рисунков.  
6. Графические редакторы.  
7. Векторные и растровые изображения.  
8. Программа PhotoShop. 
9. Векторная графика.  
10. Программа Corel Draw.  
11. Растровая графика.  
12. Цветокоррекция.  
13. Цветовые координаты.  
14. Цветовые схемы и режимы.  
15. Разрешение и разрешающая способность.  
16. Глубина пикселя. Форматы графических файлов. 
17. Классификация программных средств.  
Цель: формирование у студентов теоретических знаний и практических навыков работы с 

графическими редакторами. 
Задачи: 
− научить пользоваться программными средствами реализации информационных 

процессов; 
− сформировать навыки работы с графическим программным обеспечением. 
Ключевые вопросы: 
1. Назначением графических редакторов. 
2. Какие из графических и функциональных элементов являются стандартными при 

создании изображений? 
3.  Как создать многослойный документ? 
4.  Какие операции можно выполнить над слоями? 
5. Когда и почему рекомендуется объединять слои документа? 
6. Программы просмотра графических изображений. 
7. Векторная графика. 
8.  Растровая графика. 
9. Для какой цели применяют графические редакторы? 
10. Что представляет собой  графический  редактор CorelDraw? 
11. Назовите основные элементы окна? 
12. Назначение панели свойств. 
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13. Какой инструмент используется для выделения объектов? 
14. Каково назначение инструмента интерактивное перетекание? 
15. Что такое заливка? 
16. Как расположить текст вдоль заданной кривой? 
17. Разновидность текстов в CorelDraw. 
18. Как сделать фигуру объемной? 
19. Как сохранить часть иллюстрации с другим именем? 
Рекомендуемая литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2005, 2007. – 268 с.   
2. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
3. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безручко. – 

М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
Тема 6. Электронные таблицы 
План лекции: 
1. Первичная и производная информация.  
2. Табличные процессоры.  
3. Назначение табличных процессоров. 
4. История развития электронных таблиц.  
5. Excel и его основные возможности.  
6. Адресация ячеек, относительные и абсолютные адреса.  
7. Ввод данных в ячейку таблицы, формат ячейки.  
8. Табличные вычисления.  
9. Расчетные операции.  
10. Работа с формулами и функциями.  
11. Арифметические и логические функции.  
12. Ошибки при обработке электронных таблиц. 
Цель: формирование у студентов теоретических знаний и практических навыков работы с 

электронными таблицами. 
Задачи: 
− научить пользоваться программными средствами реализации информационных 

процессов; 
− сформировать навыки работы с табличными процессорами. 
Ключевые вопросы: 
1. Структура рабочей книги. Структура окна MS Excel, окна рабочей книги. 
2. Определения понятий: «рабочая книга», «рабочий лист», «диапазон ячеек», «ячей-

ка». 
3. Как выделить диапазон ячеек? 
4. Как выделить строку, столбец? 
5. Как по умолчанию располагаются в ячейке вводимые числовые данные? 
6. Как по умолчанию располагаются в ячейке вводимые текстовые данные? 
7. Как добавить новую строку или столбец? 
8. Как создать пользовательский список для автозаполнения? 
9. Форматы данных. 
10. Составные элементы формул. Правила записи формул. 
11. Категории функций  MS Excel. 
12. Вызов мастера функции. Вставка функции в формулу с использованием мастера 
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функций. 
13. Абсолютная, относительная и смешанная адресация. 
14. Создание диаграмм (встроенных и на отдельных листах). 
15. Типы диаграмм MS Excel и возможные области их практического применения. 
16. Основные компоненты диаграмм. Редактирование отдельных элементов. 
17. Вставка в диаграмму легенды, меток значений данных, названий диаграммы и ее 

осей. Добавление новых рядов данных. 
18. Что такое база данных? 
19. Как нужно изменить таблицу чтобы она имела вид базы данных?  
20. Что можно сделать с помощью команды Автофильтр? 
21. Какие параметры нужно установить чтобы данные выбирались при одновремен-

ном выполнении двух условий? 
22.  Какие параметры нужно установить, чтобы данные выбирались при выполнении 

хотя бы одного из двух условий? 
23. Что можно сделать с помощью команды Расширенный фильтр?  
Рекомендуемая литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2005, 2007. – 268 с.   
2. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
3. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безручко. – 

М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
Тема 7. Технология проектирования компьютерных тестов 
План лекции: 
1. Компьютерные тесты.  
2. Типы компьютерных тестов.  
3. Этапы разработки компьютерных тестов.  
4. Инструментальные тестовые оболочки. 
Цель: формирование у студентов теоретических знаний и практических навыков создания 

компьютерных тестов с помощью различных программ. 
Задачи: 
− научить пользоваться программными средствами для создания компьютерных тестов; 
− сформировать навыки работы с прикладным программным обеспечением для соз-

дания компьютерных тестов. 
Ключевые вопросы: 
1. Что такое тест? 
2. Назовите типы компьютерных тестов? 
3. Перечислите этапы разработки компьютерных тестов. 
4. Какие инструментальные тестовые оболочки вы знаете? 
Рекомендуемая литература: 
1. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
2. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безручко. – 

М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
Тема 8. Информационные и телекоммуникационные компьютерные сети. 
План лекции: 
1. Понятие компьютерной сети.  
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2. Устройства сети: сервер, рабочая станция, коммуникационные узлы.  
3. Характеристики сети.  
4. Классификация сетей по территориальному признаку: LAN, MAN, WAN сети.  
5. Эталонная модель OSI.  
6. Топология компьютерных сетей.  
7. Стек протоколов TCP/IP.  
8. Программное обеспечение компьютерных сетей: одноранговые и с выделенным 

сервером.  
9. Сетевые ОС.  
10. Понятие Интернет. История создания сети Интернет. Современная структура сети 

Интернет.  
11. Адресация в сети Интернет: IP, URL.  
12. Службы сети Интернет.  
13. Поиск информации в Интернет. 
14. Основы защиты информации и сведений, составляющих государственную тайну: 

угрозы информации в сети, основные аспекты безопасности.  
15. Методы защиты информации: криптография, электронная подпись, аутентифика-

ция, сертификация Web-узлов. 
Цель: приобретение  теоретических знаний и практических навыков выбора и исполь-

зования вычислительных систем и сетей для решения экономических и информационных за-
дач;  формирование у студентов основ защиты информации, составляющих государственную 
тайну; познакомить с методами защиты информации. 

Задачи:  
− ознакомить с общими сведениями о локальных и глобальных сетях ЭВМ; 
− сформировать  представление об основных конфигурациях сетей, типах подключе-

ния к сети; 
− научить работе с сетью с целью поиска и сохранения информации, создавать элек-

тронные ящики и пересылать электронные письма; 
− ознакомить с основами и методами защиты информации; 
− привить студентам комплекс теоретических знаний по защите информации в сети, 

познакомить с компьютерными вирусами и антивирусными программами. 
Ключевые вопросы: 
1. Дать определение компьютерной сети и её назначение. 
2. По какому принципу строиться архитектура сетей? 
3. Как классифицируются компьютерные сети по территориальному признаку? 
4. Какие существуют разновидности корпоративных сетей. 
5. Дайте определение понятие «клиент», «сервер». 
6. Какие ресурсы рабочих станций могут быть доступным для работы в локальной се-

ти? 
7. Какие задачи решаются рабочими станциями, а какие сервером? 
8. Какая основная файловая операция используется для передачи документов по ло-

кальной сети? 
9. Какие ресурсы сервера предоставляются рабочим станциям? 
10. какие компоненты входят в локальную сеть учебных классов?  
11. На каком уровне модели ISO/OSI работают протоколы TCP/IP, какие задачи они 

решают? 
12. Что такое протокол? 
13. Как вы понимаете термин служба Интернет? 
14. Как называются документы, опубликованные в Интернете в формате службы Word 

Wide Web? 
15. Для чего предназначен Браузер? 
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16. Назовите средства поиска информации в Интернет. 
17. Проблемы безопасности информации. 
18. Термин безопасность, его характеристики. 
19. Методы защиты информации: антивирусная защита, криптография, электронная 

подпись, сертификация Web-узлов, аутентификация. 
20. Что такое компьютерный вирус, признаки появления вирусов.  
21. Классифицировать вирусы по среде обитания. 
22. Классифицировать вирусы по способу заражения. 
23. Классифицировать вирусы по степени воздействия. 
24. Классифицировать вирусы по особенности алгоритмов. 
25. Какие антивирусные программы вы знаете? 
Рекомендуемая литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2005, 2007. – 268 с.   
2. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
3. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
4. Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безруч-

ко. – М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
Тема 9. Компьютерные вирусы 
План лекции: 
1. Определение вируса.  
2. История возникновения и развития вирусов.  
3. Классификация компьютерных вирусов.  
4. Антивирусные программы, их виды и использование.  
5. Антивирусные комплексы.  
6. Обновление антивирусных программ 
Цель: формирование у студентов теоретических знаний и практических навыков работы с 

антивирусными программами. 
Задачи: 
− научить пользоваться программными средствами для обнаружения и удаления компь-

ютерных вирусов. 
Ключевые вопросы: 
1. Что такое компьютерный вирус? 
2. Классификация компьютерных вирусов по различным признакам. 
3. антивирусная программа. 
4. Виды антивирусных программ. 
Рекомендуемая литература: 
1. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
2. Степанов А.Н. Информатика: базовый курс для студентов гуманитар. спец. высш. 

учеб. заведений / А.Н. Степанов. – 6-е. изд. – СПб.: Питер, 2010. – 720 с. 
3. Безручко В.Т. Информатика (курс лекций): учеб. пособие: рек. НМС / В.Т. Безруч-

ко. – М.: ФОРУМ: ИНФРА-М, 2006. – 432 с. 
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III. МЕТОДИЧЕСКИЕ УКАЗАНИЯ (РЕКОМЕНДАЦИИ) 

1. Методические указания по изучению дисциплины 
Комплексное изучение предлагаемой студентам учебной дисциплины «Новые инфор-

мационные технологии в учебном процессе» предполагает приобретение практических навы-
ков работы на ПК, творческую работу при выполнении индивидуальных самостоятельных за-
даний. 

Процесс по освоению всей совокупности теоретического и практического материала по 
дисциплине должен быть реализован в течение одного семестра и, проходить в соответствии с 
предложенным выше планом. 

В седьмом семестре изучение дисциплины «Новые информационные технологии в 
учебном процессе» основывается на практических занятиях, включающих освоение студента-
ми программных средств, таких как пакет прикладных программ Microsoft Office,  программ 
обработки графических изображений, интернет-обозревателей, владение которыми необходи-
мо любому специалисту для обучения в вузе. 

Практические занятия проводятся в компьютерных классах с применением специально 
разработанных учебно-методических пособий, в которых изложены подробные методические 
рекомендации по изучению каждой темы и выполнению заданий. Наличие таких учебно-
методических и дидактических материалов позволяет каждому студенту работать в своем ин-
дивидуальном темпе, а также дополнительно прорабатывать изучаемый материал во время са-
мостоятельных занятий, в т.ч. дома. Все эти материалы имеются на кафедре в печатном виде и 
доступны в электронном виде во всех компьютерных классах. 

Вместе с тем, каждая новая тема сначала объясняется преподавателем, рассматривается 
на примерах, затем для закрепления полученных на занятии знаний студенты выполняют соот-
ветствующие упражнения и получают домашние задания. Полученные оценки за выполненные 
упражнения и домашние задания являются основой для выставления промежуточной и итого-
вой аттестации. Итоговой аттестацией в седьмом семестре является зачет. Зачет проводится с 
использованием тестов. 

Для закрепления полученных теоретических и практических знаний студентам в тече-
ние всего семестра предлагаются индивидуальные задания для самостоятельной работы. Осо-
бенности выполнения самостоятельной работы и тематика индивидуальных заданий подробно 
изложены в методических указаниях по их выполнению. Консультирование по выполнению 
индивидуальных заданий проводится как непосредственно в компьютерных классах (во время 
консультаций). Контроль выполненных заданий осуществляется либо непосредственно на за-
нятиях, либо на консультациях. 

Наличие методических рекомендаций по изучению каждой темы, большого набора за-
даний для самостоятельной работы по закреплению изучаемого материала (как в виде элек-
тронных заданий, так и в виде печатного сборника), компьютерных тестов для контроля зна-
ний по каждой теме позволяет повысить эффективность учебного процесса. 
Для подготовки к зачету студентам рекомендуются подготовленные преподавателями кафедры 
учебник и практикум, включающий терминологическую часть, вопросы для самоконтроля и 
тесты.  

2. Методические указания к практическим занятиям 
Задачей преподавателя при проведении практических занятий является грамотное и дос-

тупное разъяснение принципов и правил проведения работ, побуждение студентов к самостоя-
тельной работе, определения места изучаемой дисциплины в дальнейшей профессиональной ра-
боте будущего специалиста. 

Цель практического занятия – научить студентов самостоятельно производить  необходи-
мые  действия для достижения желаемого  результата. 

 Прежде чем приступить к выполнению заданий практического занятия, студенту необхо-
димо ознакомиться с теоретическим материалом, соответствующим данной теме. 

Выполнение заданий целесообразно разделить на  несколько этапов: 
− формулировка и обоснование цели работы; 
− определение теоретического аппарата, применительно к данной теме; 
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− выполнение заданий; 
− анализ результата; 
− выводы. 
Индивидуальные задания для практических занятий должны быть представлены конкрет-

но-практическими и  творческими задачами. 
На первой ступени изучения темы выполняются конкретно-практические задачи, при ре-

шении которых формируется минимальный набор умений. Преподаватель опосредованно руко-
водит  познавательной деятельностью студентов, консультирует и подробно разбирает со сту-
дентами возникшие затруднения в ходе решения задачи, обращает внимание группы на возмож-
ные ошибки.  

Вторая ступень изучения темы  дифференцируется в зависимости от степени усвоения его 
обязательного уровня. Студенты, усвоив содержание типовых методов и приемов решения задач, 
приступают к решению творческих задач. Если уровень знаний и умений, демонстрируемых сту-
дентом при контрольном обследовании, не соответствует установленным требованиям, студент 
вновь возвращается к стандартным упражнениям, но под более пристальным наблюдением пре-
подавателя. 

После изучения отдельной темы курса дисциплины, каждый студент получает оценку по 
результатам выполнения заданий. 

Студенты, пропустившие практические занятия, должны их выполнить во внеаудиторное 
время и отчитаться до начала зачетно-экзаменационной сессии. 

Рекомендации для организации рабочего места студента: для проведения практических 
занятий требуется компьютерный класс с установленным программным обеспечением. 

Правила техники безопасности в компьютерном классе: 
1. Находиться в компьютерном классе без разрешения преподавателя. 
2. Включать без разрешения оборудование. 
3. Трогать разъемы соединительных кабелей и проводов. 
4. Прикасаться к питающим проводам и устройствам заземления. 
5. Включать и выключать аппаратуру без указания преподавателя. 
6. Работать в верхней одежде и влажными руками. 
7. Класть диски, книги, тетради и другие предметы на монитор и клавиатуру. 
8. При появлении запаха гари немедленно прекратите работу, выключите аппаратуру и 

сообщите об этом преподавателю. 
Методические указания к практическим занятиям 

Тема: Создание текстовых документов. 
План: 
1. Создание текстового документа.  
2. Форматирование текстов.  
3. Создание таблиц и схем.  
4. Списки, стили, оглавления.  
5. Создание и редактирование формул. 
Объем аудиторных часов: 4 ч. 
Объем часов для самостоятельной работы: 3 ч. 
Указания к практической работе: 

1. Отформатировать приведенный ниже текст согласно заданий. 
2. На первой странице расположить текст согласно рисунка. Ориентация страницы – 

книжная. Для текста задать следующее форматирование: 
заголовки «Установка параметров страницы», «Линейки»: шрифт – Times New Roman, 

размер шрифта – 16, цвет шрифта – синий, начертание – полужирный; 
фраза «УСТАНОВИТЬ!» и абзац после нее: шрифт – Times New Roman, размер шрифта – 

14, цвет шрифта – бордовый; 
основной текст: шрифт – Times New Roman, размер шрифта – 14. 
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3. На второй странице расположить ниже приведенный текст. Ориентация страницы – 

книжная. Для заголовков «Форматирование шрифта», «Форматирование абзацев» задать: 
шрифт – Times New Roman, размер шрифта – 16, цвет шрифта – синий, начертание – полу-
жирный. 
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4. На третьей странице расположить ниже приведенный текст. Ориентация страницы 
– альбомная. Для текста задать следующее форматирование: 

фразы «Эта маркированный список»» и «Это нумерованный список»: шрифт – Times 
New Roman, размер шрифта – 14; 

заголовки «Колонки», «Колонтитулы», «Жесткий переход», «Редактор формул», 
«Списки»: шрифт – Times New Roman, размер шрифта – 16, цвет шрифта – синий, начерта-
ние – полужирный; 

основной текст: шрифт – Times New Roman, размер шрифта – 14. 

 
5. На четвертой странице расположить ниже приведенный текст. Ориентация страни-

цы – книжная. Для текста задать следующее форматирование: 
заголовок «Автоматическое оглавление»: шрифт – Arial Narrow, размер шрифта – 14, 

цвет шрифта – красный; 
основной текст: шрифт – Arial Narrow, размер шрифта – 14. 
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Литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 
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3. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
Тема: Обработка графического изображения. 
План: 
1. Создание простейших изображений в графическом редакторе CorelDraw. 
2. Создание простейших изображений в графическом редакторе PhotoShop. 
Объем аудиторных часов: 2 ч. 
Объем часов для самостоятельной работы: 3 ч. 
Указания к практической работе: 

В качестве отчетной работы требуется создать визитку с учетом основных правил 
подготовки изображений к печати в типографии и вывести на лист А4 при помощи автома-
тического расположения на листе. 

1. Создание визитки 
− Устанавливаем размер листа под размер визитки (90х50) 
− Заполняем документ содержимым (в данном случае это несколько надписей и рас-

тровая картинка) 
− Важно! Видимую рамку к визитке делать нельзя, т.к. из-за погрешностей при об-

резке рамка будет иметь неодинаковую толщину или с каких-то сторон ее не будет вообще. 
− Сохраняем документ. 
В результате получаем: 
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2. Подготовка к печати 
− Входим в «print preview» 
− В режиме «Imposition layout tool» выбираем нужное число копий по вертикали и 

горизонтали. 

 
− В режиме «Marks placement tool» устанавливаем метки для обрезки 

 
− Теперь, если нужно, такой стиль оформления можно сохранить (file => save frint 

style as…). Документ готов к печати. 
Создание контурного и обведенного текста 

Инструмент Type (Текст) обладает незначительными возможностями создания конту-
ров. Невозможно задать толщину обводки, нельзя выбрать режим наложения или установить 
величину непрозрачности. Обычно для ввода и обводки текста перед импортом в Photoshop 
используют программу типа Illustrator. Если это невозможно, то для создания контуров вос-
пользуйтесь командой Stroke (Выполнить обводку) меню Edit (Редактирование). 

Прозрачный текст с цветным контуром можно создать, выполнив следующие дейст-
вия: 

1. Выберите инструмент Type Mask (Текст-маска) и щелкните на открытом изображе-
нии или на новом слое, в котором хотите поместить текст. 

2. Введите текст. Оставьте выделенную область активной для выполнения последую-
щих действий. 

3. Задайте желаемый цвет контура. 
4. В меню Edit (Редактирование) выберите команду Stroke (Выполнить обводку) и 

введите необходимые значения. 
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Для создания окрашенного текста, контур которого имеет другой цвет, выполните 
следующие действия: 

1. Задайте основной цвет, соответствующий цвету текста. 
2. Выберите инструмент Type (Текст), щелкните на новом слое и введите требуемый 

текст. 
3. Выполните Select → Load Selection, чтобы выделить текст по контуру и склейте 

слои (Ctrl + E). 
4. Задайте основной цвет, соответствующий цвету обводки. 
5. В меню Edit (Редактирование) выберите команду Stroke (Выполнить обводку) и 

введите необходимые значения. 
2. Пламя. 
Нам потребуется однослойное изображение - белая надпись на черном фоне. Удобнее 

всего использовать режим серых полутонов. Эффект пламени более выразителен на широком 
светлом шрифте без засечек. Можно применить и массивный шрифт, обведя буквы по кон-
туру. 

Первый этап состоит в применении фильтра Wind, вызываемого через меню Filter → 
Stylize. Перед вызовом эффекта ветра надо повернуть изображение на 90o по часовой стрелке 
(команда Image → Rotate Canvas → 90o CW), поскольку в фильтре Wind нет вертикального 
направления ветра. Мы включим направление From the right, а силу ветра оставим мини-
мальную - Wind. Чтобы следы ветра получились более мощными, можно применить фильтр 
несколько раз подряд, нажав клавиши Crtl + F. После чего возвращаем изображение в нор-
мальное положение командой меню Image → Rotate Canvas → 90o CCW. 

Придадим надписи и языкам ветра рваную форму, более соответствующую пламени. 
Для этого воспользуемся фильтром Diffuse, вызвав его через то же меню Filter → Stylize и 
установив режим Normal. 

Далее применим фильтр Gaussian Blur при небольшом радиусе. В данном случае он 
составил 1.3 пиксела. Усилим дрожание с помощью фильтра Ripple (рябь), который вызыва-
ется через меню Filter → Distort. Зададим амплитуду (Amount) порядка 80 - 100, да и длина 
волны пусть будет небольшой, выберем Small или Medium. 

На последнем этапе надо перевести изображение из черно-белого полутонового в ин-
дексированный цвет Image → Mode → Indexed Color. Изменить палитру изображения с ин-
дексированным цветом можно с помощью команды меню Image → Mode → Color Table. Ре-
дактор Photoshop предлагает несколько заранее подготовленных палитр, из которых выберем 
Black Body. 

3. Лед. 
Создадим новое изображение и напишем на нем текст черным цветом. Затем выпол-

ним Select → Load Selection и Layer → Flatten Image. 
Выполним команду Select → Inverse, и применим фильтр Filter → Pixelate → 

Crystallize с коэффициентом кристаллизации равным 8. 
Опять выполняем команду Select → Inverse, и применяем фильтр Filter → Noise → 

Add Noise с коэффициентом шума около 70 (включите Distribution: Gaussian). 
Размываем избражение фильтром Filter → Blur → Gaussian Blur с коэффициентом 

размывки около 2. Затем отменяем выделение Select → None и используем фильтр Filter → 
Blur → Blur. 

Выполняем команду Image → Adjust → Invert (Ctrl + I). 
Повернем изображение Image → Rotate Canvas → 90 CW. Затем применяем фильтр 

Filter → Stylize → Wind (Method: Wind, Direction: From the left) и возвращаем картинку в го-
ризонтальное положение Image → Rotate Canvas → 90 CCW. 
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Придадим изображению цвет льда с помощью команды Image → Adjust → 
HueSaturation (Включите Colorize, установите параметр Hue в положение - 181, а Saturation - 
80). 

Добавим искрящиеся блики с помощью дополнительных кистей. В меню Brushes 
(Кисти) выберите команду Load Brushes (Загрузить Кисти) и откройте файл assorted.abr из 
подкаталога Brushes. Установите текущим белый цвет и нанесите искорки на некоторые вы-
ступающие льдинки. 

4. Золотая надпись. 
Создаем новый белый лист. Переходим в палитру каналов и, нажав на кнопку внизу 

этой палитры, создаем канал #4. Его фон должен быть черным, а текст белым. Пишем текст. 
Этот эффект наиболее выразителен при использовании крупных символов. 

Активизируем единственный слой Background он должен быть белым. Маску из кана-
ла #4 загружаем в окно редактора комбинацией клавиш [Ctrl]+[Alt]+[4]. Закрашиваем ее чер-
ным. Залить маску основным цветом можно клавишами [Alt]+[Del]. Выключаем маску, на-
жав [Ctrl]+[D]. 

Надпись на слое Background надо растушевать с помощью гауссового фильтра (Filters 
→ Blur → Gaussian Blur). Радиус в 3 пиксела. 

Переименуем этот слой. Щелкните дважды мышкой по пиктограмме слоя Background 
в палитре слоев. Затем необходимо продублировать слой. Для этого перетащите мышкой в 
палитре слоев дублируемый слой на кнопку создания нового. 

Слои надо сдвинуть друг относительно друга (Filter → Other → Offset). Для одного из 
слоев набираем два положительных смещения на 4 пиксела, а для другого - два отрицатель-
ных по 4 пиксела. 

Для верхнего из слоев (Layer 0 copy) режим наложения заменяем с Normal на 
Difference (разница). Теперь слои объединяем в один [Ctrl]+[Е].  

Нажав комбинацию клавиш [Ctrl]+[М], Вам надо попытаться воспроизвести кривую, 
подобную той, что на иллюстрации. 

Загружаем маску #4 командой меню Select → Load Selection, затем маску инвертируем 
[Ctrl]+[Shift]+[I]. Убедившись, что маска включает в себя не надпись, а фон вокруг нее (об 
этом свидетельствует бегущая штриховая линия по краю окна редактора), нажмите клавишу 
[Del]. 

Нажимаем [Ctrl]+[D] и [Ctrl]+[I] - инвертирование. Создаем новый слой (цветной) 
Слой1. Подбираем ему из каталога золотистый цвет. Делаем заливку [Ctrl]+[Del]. Делаем для 
Слой0 цветность. 

Надо объединить слои в срезаемую группу. Получаем ее, щелкнув мышкой при нажа-
той клавише [Alt] по линии, разделяющей слои в палитре Layers. 

Создаем новый слой Слой2, делаем его цветным. В каталоге выбираем черный цвет и 
нажав [Ctrl]+[Del] заливаем. Расположите слои в такой последовательности: слой1, слой2, 
слой0. 

5. Эффект «X-Files». 
Создайте новое изображение RGB с чёрным фоном. Напишите ваш текст. Далее необ-

ходимо объединить слои (Ctrl + E). Теперь, откройте палитру Каналы (Window → Show 
Channels); переместите любой из каналов к значку новый канал. Это создаст новый канал. 
Откройте двойным щелчком мыши свойства этого канала и переименуйте его в «оригинал». 

Перетащите канал «оригинал» к значку нового канала и сделайте дубликат. Дважды 
щелкните на новом канале, и переименуйте его в «белый». Затем нажав Ctrl + щелчок мыши 
на канале, загрузите его в выделение. Теперь мы немного расширим его. Используйте Select 
→ Modify → Expand со значением 1 пиксела. Далее выполните Edit → Fill use: white. Сними-
те выделение Select → Deselect и выполните размывку Filter → Blur → Gaussian Blur с радиу-
сом равным 2. 
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Перетащите канал «белый» к значку новый канал, чтобы у нас получился ещё один 
канал. Дважды щёлкните на образовавшемся канале, и переименуйте его в «жёлтый». Ctrl + 
щелчок, чтобы загрузить в выделение. Опять, Select → Modify → Expand со значением 2. За-
полните белым цветом, снимите выделение и примените фильтр Filter → Blur → Gaussian 
Blur с радиусом 3. 

Последний канал мы получим следующим образом - перетащите канал «желтый» к 
значку новый канал. Переименуйте его в «зелёный», Ctrl + щелчок; расширьте на 4. Заполни-
те белым, снимите выделение, размойте с радиусом 7 пикселов. 

Переключитесь на канал RGB. Выполните Select → Load Selection и выберите там ка-
нал «зелёный». Теперь выберите подходящий зеленый цвет, например R:0 G:255 B:0. И вы-
полните заливку Edit → Fill use: Foreground Color. 

Сделайте тоже самое для канала «жёлтый», но с использованием цвета R:128 G:255 
B:0. Теперь тоже самое сделайте для канала «белый», используя белый цвет. Загрузите «ори-
гинал», выполните Select → Modify → Contract установка - 1 пиксел и залейте черным Edit → 
Fill use: black. 

Тема: Электронные таблицы. 
План: 
1.Создание простейшей таблицы.  
2. Ввод и редактирование данных.  
3. Формат данных.  
4. Адресация. Вычисления в таблицах.  
5. Сортировка данных и форматирование таблиц.  
6. Графический анализ данных. 
Объем аудиторных часов: 2 ч. 
Объем часов для самостоятельной работы: 3 ч. 
Указания к лабораторной работе: 

1. Назвать Лист1 – Прайс_лист фирмы «Альфа». Заполнить на листе следующую таб-
лицу. 

Прайс-лист 
Наименование това-

ра 
Цена за 

штуку, руб. 
Количество, 

штук 
Скидка 

Стоимость 
без скидки 

Стоимость 
со скидкой 

Телевизор 7650 8 3%   
Магнитофон 4500 12 0%   
Компьютер 31000 5 0%   
Принтер 6100 5 2%   
Сканер 5200 2 0%   
Дискета 15 570 5%   
Телефон Sony 6400 15 15%   
Монитор LG 6800 35 5%   
Итого:      

Выделить заголовки столбцов жирным шрифтом, наименование товара – шрифтом 
синего цвета. 

Найти стоимость без скидки и стоимость со скидкой. 
Выделить с помощью условного форматирования (Формат→ Условное форматиро-

вание) в таблице те товары, цена за штуку которых превышает 8000 рублей, установив стиль 
ячейки – Результат 2. 

Создать прейскурант для пересчета стоимости товаров в рублях на доллары в соответ-
ствии с текущим курсом доллара.  

Прейскурант 
Курс пересчета 1 у.е.   
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Наименование товара Стоимость без скидки (руб.) стоимость(у.е.) 
Телевизор   
Магнитофон   

…      
2. Автозамена. Вызвать команду Сервис →Автозамена. Убедитесь, что отмечена га-

лочкой опция «заменять при вводе». В поле Заменить: фА, а в поле  На: фирма  «Альфа».  

Чтобы получить результат, нужно выделить любую пустую ячейки, ввести фА, и нажать кла-
вишу Enter. 

3. Рабочий лист должен содержать сводную ведомость студенческих оценок по ито-
гам сессии. Если экзамены сданы без троек, то соответствующая ячейка таблицы должна 
быть зелеными и, если у студента остались задолженности – красными. 

Переименовать новый рабочий лист как «Ведомость» и создать на нем нижеприве-
денную таблицу. 

№ Ф.И.О. Информати-
ка 

Экономи-
ка 

Матема-
тика 

Средний 
балл 

Сти-
пендия 

Доп-
лата 

1 Петров Е.П.       
… …       
10 Сидорова А.Н.       

Заполнить таблицу. Экзаменационные оценки должны изменяться от 2 до 5 баллов. 
В ячейку G2 ввести значение фиксированной доплаты – 500 руб. 
Найти: средний балл каждого студента; стипендию, если студент имеет средний балл 

больше или равный 4, то стипендия равна 2000 руб. плюс фиксированная доплата, иначе 500 
руб.; количество 5, 4, 3, 2 по каждому предмету (функция СЧЕТЕСЛИ). 

Вычислить средний балл группы. 
Задать условное форматирование для студентов. Если оценка больше 3, то стиль ячейки – 

Результат 2; а если оценка меньше или равна 3, то стиль ячейки – Результат 1. 
4. Студенты сдают зачет, который предусматривает систему оценивания «зачет» и «неза-

чет». Оценка «зачет» ставится, если из 10 вопросов они, верно ответили больше чем на половину 
вопросов, т.е. на 6, в противном случае ставится оценка «незачет». Надо автоматизировать про-
цесс выставления зачета. 

 A B … K L M 
1 Фамилия Вопрос 1 … Вопрос 10 Общая сумма Зачет/незачет 
2 Иванов К.И.      
3 Петрова Е.Л.      
4 Борисова Л.Ю.      
5 Григорьева Е.К.      
6 Сидоров В.Е.      

5. Дана таблица покупок за июль 2008 г. 
Таблица покупок за июль 2008 г. 

  Скидка %   Дается при стоимости покупки свыше 500 руб. 

№ Товар Дата Цена Количество Стоимость Скидка 
Итоговая 
стоимость 

1 Ракетка 01.07.2008 500 руб. 6 руб. руб. руб. 
…               
10 Мяч 31.07.2008 354 руб. 4       

    Сумма      
    Среднее      

В поле «Скидка» используется функция «ЕСЛИ». Скидка дается, если стоимость по-
купки выше 500 руб., иначе скидка 0 руб. Изобразить график выручки в июле (поле «Итого-
вая стоимость», подписи «Дата»). 

6. Дан отчет продажи авиабилетов офиса авиакомпании. Найти значения полей «Ми-
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нимум», «Максимум», «Среднее».  

  2002 г. 2003 г. 2004 г. Среднее 

1 квартал 2 600 руб. 4 400 руб. 4 120 руб.   

2 квартал 3 400 руб. 3 900 руб. 3 800 руб.   

3 квартал 4 700 руб. 5 600 руб. 3 100 руб.   

4 квартал 3 500 руб. 3 400 руб. 4 800 руб.   

Минимум         

Максимум         
8. Создать таблицу «Прием в секцию волейбола», заполнив ее не менее чем 10 запи-

сями. Вывести сообщение, в котором будет отображаться, принять учащегося в секцию или 
нет. Учащийся 1 курса экономического факультета ростом не менее 174 см будет принят в 
секцию; найти, сколько учащихся в итоге поступило в секцию.    

№ Фамилия Курс Возраст Рост Зачисление в секцию 

      
      

Литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2000, 2005, 2001. – 268 с.   
2. Информатика. Базовый курс: учеб.: рек. Мин. обр. РФ / Ред. С.В. Симонович. – 

СПб.: Питер, 2000, 2004, 2005, 2006. – 638 с.  
3. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с.    
Тема: Технология проектирования компьютерных тестов. 
План: 
1. Создание интерактивных тестов в программе MS Excel.  
2. Создание  тестов в MS PowerPoint.  
Объем аудиторных часов: 2 ч. 
Объем часов для самостоятельной работы: 5 ч. 
Указания к практической работе: 

Создание теста с помощью стандартных команд и функций MS Excel 

MS Excel содержит набор стандартных функций. 
Создадим тест, состоящий из 5 вопросов. 
Для этого: 
1. В ячейки В1, В3, В5, В7, В9 набираем текст вопросов. 
2. Набираем варианты ответов: 
В столбец К набираем варианты ответов на вопрос №1 (ячейка В1). 
В столбец L набираем варианты ответов на вопрос №2 (ячейка В3). 
В столбец М – на вопрос №3 (ячейка В5). 
В столбец N – на вопрос №4 (ячейка В7). 
В столбец О – на вопрос №5 (ячейка В9). 
 Оформляем ячейки с ответами: 
В ячейку В2 вносим проверку данных: 
− Курсор устанавливаем в ячейку В2. 
− Запускаем пункт меню Данные-Проверка. 
− На вкладке Параметры заполняем тип данных Список и источник данных – указы-

ваем столбец с вариантами ответов. 
− на вкладке Сообщение для ввода записываем сообщение «Выберите ответ!». 

− Щелкаем ОК. 
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Аналогичные действия проводим с ячейками В4, В6, В8, В10. 
В ячейку К5 вводим формулу =ЕСЛИ(В2=К1;1;0) – в данном случае в ячейке К1 – 

правильный вариант ответа 
Аналогично заполняем ячейки L5, M5, N5, O5. 
3. В ячейку Р5 вводим формулу считающую общий балл =СУММ(К5:О5) 
В ячейку В11 вводим формулу, определяющую оценку выполненному тесту:  

=ЕСЛИ(Р5=5;5;ЕСЛИ(Р5=4;4;ЕСЛИ(Р5=3;3;2))) 
Далее необходимо отформатировать тест. 
Варианты ответов (столбцы К, L, M, N, O) лучше скрыть (Формат-Столбец-Скрыть), 

либо выбрать белый цвет шрифта. 
Создание теста с помощью макросов 

Создадим тест, состоящий из 5 вопросов с помощью макросов. Уровень безопасности 
должен быть низкий (Сервис-Макрос-Безопасность-Низкая) 

Для этого: 
1. Создадим 7 листов, используя пункт меню Вставка-Лист. 
2. Заполняем листы надписями: 
− на первом листе одна фигура «Начать тест»; 
− на последнем – две фигуры «Ваша оценка» и «Вернуться в начало теста?»; 
− на остальных – одна «содержание вопроса» и фигуры с вариантами ответов 

(сколько их будет – зависит от Вас). 
3. Теперь необходимо создать макросы, заставляющие работать Ваш тест. 
3.1. Макрос, запускающий тест: 
− курсор устанавливаем на лист 1 в ячейку А1; 
− запускаем команду Сервис-Макрос-Начать запись; 
− в окне задаем имя макросу Начало_теста (обратите внимание! Пробелы в имени 

макроса не допускаются); 
− щелкаем ОК (окно закрывается и идет запись макроса); 
− щелкаем по фигуре «Начать тест», затем по ярлыку второго листа; 
− заходим в меню Сервис-Макрос-Остановить запись; 
− щелкаем по фигуре правой кнопки мыши; 
− выбираем Назначить макрос; 
− в открывшемся окне выбираем Начало_теста; 
− щелкаем ОК. 
Для проверки можно, предварительно поставив курсор в любую ячейку (допустим 

А1), щелкнуть по фигуре. В результате Вы окажетесь на втором листе книги. 
3.2. Макрос, работающий с правильным вариантом ответа 
− курсор устанавливаем на лист 2 в ячейку А1; 
− запускаем команду Сервис-Макрос-Начать запись; 
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− в окне задаем имя макросу Лист_2_правильно (обратите внимание! Пробелы в 
имени макроса не допускаются); 

− щелкаем ОК (окно закрывается и идет запись макроса); 
− щелкаем по фигуре «правильный ответ», затем по ячейке А1, записываем в нее 

цифру 1, затем по ярлыку третьего листа; 
− заходим в меню Сервис-Макрос-Остановить запись; 
− щелкаем по фигуре правой кнопки мыши; 
− выбираем Назначить макрос; 
− в открывшемся окне выбираем Лист_2_правильно; 
− щелкаем ОК. 
3.3. Макрос, работающий с неправильным вариантом ответа 
− курсор устанавливаем на лист 2 в ячейку А1; 
− запускаем команду Сервис-Макрос-Начать запись; 
− в окне задаем имя макросу Лист_2_неправильно (обратите внимание! Пробелы в 

имени макроса не допускаются); 
− щелкаем ОК (окно закрывается и идет запись макроса); 
− щелкаем по фигуре «неправильный ответ», затем по ярлыку третьего листа; 
− заходим в меню Сервис-Макрос-Остановить запись; 
o щелкаем по фигуре с неправильным ответом правой кнопки мыши; 
o выбираем Назначить макрос; 
o в открывшемся окне выбираем Лист_2_неправильно; 
o щелкаем ОК; 

− последние 4 пункта повторяем с остальными фигурами с вариантами неправильно-
го ответа 

3.4. Далее проделываем операции пунктов 3.2 и 3.3 на остальных листах с вопросами, 
изменяя номера листов в названиях макросов (Лист_3_правильно, Лист_4_правильно и т.п.) 

3.5. Макрос, работающий с возвратом к началу теста 
− курсор устанавливаем на лист 7 в ячейку А1; 
− запускаем команду Сервис-Макрос-Начать запись; 
− в окне задаем имя макросу вернуться_к_началу_теста (обратите внимание! Про-

белы в имени макросане допускаются); 
− щелкаем ОК (окно закрывается и идет запись макроса); 
− щелкаем по фигуре «вернуться к началу теста?», затем на лист 6 по ячейке А1, на 

клавишу Del, затем на лист 5 по ячейке А1, на клавишу Del, затем на лист 4 по ячейке А1, на 
клавишу Del, затем на лист 3 по ячейке А1, на клавишу Del, затем на лист 2 по ячейке А1, на 
клавишу Del, затем по ярлыку первого листа; 

− заходим в меню Сервис-Макрос-Остановить запись; 
− щелкаем по фигуре «вернуться к началу теста?» правой кнопки мыши; 
− выбираем Назначить макрос; 
− в открывшемся окне выбираем вернуться_к_началу_теста; 
− щелкаем ОК. 
3.6. Теперь нужно посчитать оценку. 
Для этого 
− в любую ячейку листа 7 (например, А1) вставляем формулу 

=СУММ(Лист2!A1;Лист3!A1;Лист4!A1; Лист5!A1; Лист6!A1) 
− теперь в ячейку, располагающуюся рядом с фигурой «Ваша оценка» вставляем 

формулу подсчета оценки 
=ЕСЛИ(А1=5;5;ЕСЛИ(А1=4;4; ЕСЛИ(А1=3;3;2))) 
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3.7. Для удобства контроля и невозможности со стороны учащихся изменить тест, 
воспользуйтесь командой пункта меню Сервис-Параметры. На вкладке Вид уберите все 
флажки на каждом листе книги в отдельности.  

3.8. Тест составлен. Осталось его отформатировать. 
Создание  тестов в MS PowerPoint. 

 Использование готового шаблона. 

1. Откройте файл shablon.ppt.  Если в момент открытия документа появилось преду-
преждение системы безопасности, то нажмите кнопку «Не отключать макросы». Сразу со-
храните файл под другим именем, чтобы не испортить заготовку. 

2. В подзаголовке первого слайда укажите тему, по которой будете создавать тест.  
3. Переходим ко второму слайду. В разделе текста слайда наберите вопрос. Ниже 

укажите варианты ответов.  
4. Внизу справа на слайде есть кнопка «Следующий вопрос» - дважды щелкните по 

ней. Откроется окно программы Visual Basic: 
В этом окне Вы видите код, который описывает события, происходящие при нажатии 

на кнопку. Т.к. нашей задачей не является изучение этого кода, то не будем вдаваться в под-
робности. Вам лишь надо в строке  If OptionButton1.Value = True Then вместо единицы ука-
зать цифру (2, 3 или 4), обозначающую правильный ответ на ваш вопрос. Если в вашем спи-
ске вариантов ответов правильным является первый ответ, то ничего менять не надо – просто 
закройте Visual Basic. Слайд готов. 

5. Для создания слайда второго вопроса просто копируем готовый слайд. Меняем но-
мер вопроса, формулировку и варианты ответов. Дважды щелкаем по кнопке «Следующий 
вопрос» и повторяем уже знакомую манипуляцию - указываем номер правильного ответа в 
строке кода If OptionButton1.Value = True Then. Кроме этого, надо удалить строчки, в кото-
рых обнуляются значения переменных z = 0, k = 0, pr = 0 (если этого не сделать, то резуль-

тат будет вычисляться не правильно).  

 
 

6. Копируем последний созданный слайд и оформляем третий вопрос, меняя в коде 
номер правильного ответа.  Таким образом, создаем нужное  количество слайдов. Сохраняем 
презентацию (целесообразно сохранить презентацию и в режиме демонстрации и именно 

этот файл использовать для проверки знаний). Если после запуска презентации не работают 
кнопки, то откройте в Power Point меню Сервис → Макрос → Безопасность и выберите 
средний или низкий уровень безопасности. При запуске презентации не отключайте макро-
сы.  

 
Разработка теста в MS PowerPoint. 

1 этап: Создадим тест из 9 вопросов по теме «Устройство компьютера». 
Вопросы: 

1. Манипулятор «мышь» - это устройство … 
а. ввода информации 
б. вывода информации 

в. обработки информации 
г. хранения информации 
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2. При выключении компьютера информа-
ция стирается 

а. в ПЗУ 
б. на жестком диске 
в. в оперативной памяти 
г. нигде не стирается 
3. За обработку информации отвечает 

а. процессор 
б. дигитайзер 
в. дисплей 
г. винчестер 
4. Какое из перечисленных устройств явля-

ется лишним в данной группе? 
а. принтер 
б. плоттер 
в. монитор 
г. сканер  
5. Производительность работы компьютера 

(скорость выполнения операций) зависит 
от… 

а. скорости нажатия клавиш 
б. разрешения монитора 
в. тактовой частоты процессора 
г. объема винчестера 
 
6. Оперативная память предназначена для  

а. выполнения арифметических и логических 

операций 
б. управления процессами передачи данных 
в. контроля за состоянием устройств  
г.  хранения активных программ и данных 
 
7. Одной из главных характеристик монито-

ра является ...  
а. тактовая частота 
б. разрешение  
в. разрядность адресной шины 
г. марка производителя 
8.  устройствам хранения данных не отно-

сится...  
а. винчестер  
б. дигитайзер  
в. флоппи-диск  
г. лазерный диск 
9. Диски каких типов можно перезаписы-

вать многократно? 
а. CD-R и DVD-R 
б. CD-R и CD-RW 
в. CD-RW и DVD-RW 
г. DVD-R и DVD-RW 
 

 

2 этап:  Запускаем приложение MS PowerPoint.  Оформляем первый титульный слайд по 
своему вкусу. Создаем второй слайд. В заголовке слайда укажите номер вопроса, в тексте слайда 
– его формулировку. Для оформления  вариантов ответов будем использовать элементы управ-
ления. Меню «Вид» → Панели инструментов → Элементы управления. Выбираем элемент «Пе-
реключатель» и щелкаем по слайду.  

На панели «Элементы управления» нажимаем кнопку «Свойства» (или кликнуть пра-
вой клавишей мыши по переключателю и выбрать пункт «Свойства»). 

В появившемся окне выполняем ряд настроек:  
1 - цвет фона переключателя 
2 - текст переключателя (вариант ответа) 
3 - параметры текста (шрифт, размер, начертание) 
4 - цвет текста 

Установите эти параметры по своему усмотрению.  
Первый переключатель готов. Копируем его,  вставляем его на этот же слайд. Открываем 

свойства второго переключателя и меняем текст переключателя. Остальные параметры оставля-
ем без изменения. Таким же образом создаем третий и четвертый переключатели.  

Для перехода к следующему вопросу создадим кнопку. Выбираем на панели «Элементы 
управления»  соответствующий элемент «Кнопка». Щелкаем по слайду, вызываем свойства 
кнопки (кликнуть правой клавишей мыши по кнопке и выбрать пункт «Свойства»), настраиваем 
цвет и текст кнопки по аналогии с переключателем.  

Отменяем смену слайда по щелчку: меню «Показ слайдов» → Смена слайдов… → Смена 

слайда → снимаем галочку «по щелчку». Слайд с 1 вопросом готов. 
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Дублируем готовый слайд (Меню «Вставка → Дублировать слайд)   Меняем номер во-

проса, его формулировку и варианты ответов на переключателях. Таким образом, подготавлива-
ем все слайды с вопросами.  

Осталось оформить последний слайд, на который  будут выводиться  результаты теста. 
Кнопки «Получить результат» и «Закончить тест» создаются с помощью элемента «Кнопка» (как 

было описано выше). 
Окно свойств элемента «Надпись» приводится ниже. 

 
3 этап: Для того, чтобы результаты теста определялись автоматически, необходимо 

написать для каждого элемента  код обработки его события с помощью языка Visual Basic, 
который встроен во все приложения MS Office. Если вы не владеете основами программиро-
вания на VBA, то просто следуйте инструкциям, изложенным ниже. 

Описываем переменные. Откройте слайд с первым вопросом теста и дважды щелкни-
те по кнопке «Следующий вопрос». Откроется окно программы Microsoft Visual Basic. От-
кройте меню Insert и выберите пункт Module. В появившемся окне наберите строчку как на 
рисунке или скопируйте отсюда: Public k, z pr As Integer. 
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Переменная k служит для подсчета количества правильных ответов; 

Переменная z  для подсчета количества вопросов; 

Переменная pr для определения процента правильных ответов.  

Опять открываем слайд с первым вопросом и дважды щелкаем по кнопке «Следую-
щий вопрос». В появившемся окне опишите события по образцу или скопируйте отсюда: 
z = 0 
k = 0 
pr = 0 
If OptionButton1.Value = True Then 
k = k + 1 
End If 
z = z + 1 
OptionButton1.Value = False 
OptionButton2.Value = False 
OptionButton3.Value = False 
OptionButton4.Value = False 
SlideShowWindows(1).View.Next 
 

Открываем слайд со вторым вопросом и дважды щелкаем по кнопке «Следующий во-
прос». Копируем аналогичный код, за исключением обнуления переменных z, k, pr. Обратите 
внимание на строку If OptionButton1.Value = True Then - в ней единичка меняется на тройку, 
т.к. правильный ответ на второй вопрос – третий. Таким образом  код должен быть таким: 

 
If OptionButton3.Value = True Then 
k = k + 1 
End If 
z = z + 1 
OptionButton1.Value = False 
OptionButton2.Value = False 
OptionButton3.Value = False 
OptionButton4.Value = False 
SlideShowWindows(1).View.Next 

 
Такой же код копируем для остальных слайдов с вопросами теста, меняя только номе-

ра правильных ответов в строке  If OptionButton3.Value = True Then. 
Открываем последний слайд. Дважды щелкаем по кнопке «Получить результат» и  

копируем туда следующий код: 
 
Label1.Caption = z 
Label2.Caption = k 
pr = (k / z) * 100 
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Label3.Caption = pr 
If pr >= 80 Then 
Label4.Caption = "Отлично" 
End If 
If pr < 80 And pr >= 50 Then 
Label4.Caption = "Хорошо" 
End If 
If pr < 50 And pr >= 25 Then 
Label4.Caption = "Удовлетворительно" 
End If 
If pr < 25 Then 
Label4.Caption = "Неудовлетворительно" 
End If 
 
Slide11.Application.Quit 
 

 
 

Сохраняем презентацию (можно сохранить в режиме демонстрации). В случае если 
кнопки не работают, откройте меню Сервис → Макрос → Безопасность и выберите средний 
или низкий уровень безопасности. При запуске презентации не отключайте макросы. 

Тема: Работа с электронной почтой. 
План: 
1. Электронная почта в Интернет.  
2. Создание собственной учетной записи в Outlook.  
3. Подписка на рассылки.  
4. Создание адресной книги. 
5. Настройка правил для сообщений. 
Объем аудиторных часов: 2 ч. 
Объем часов для самостоятельной работы: 10 ч. 
Указания к практической работе: 

При пересылке сообщений по электронной почте необходимо указывать адрес полу-
чателя в сети Интернет, который имеет следующую структуру: 

<имя пользователя>@<адрес компьютера> 
Имя пользователя может представлять собой любую последовательность латинских 

букв и включать несколько сегментов, разделенных точкой. Смысловое значение имени 
пользователя сожжет быть самым разнообразным: фамилия, имя, фамилия и инициалы, на-
звание подразделения и т.п. 

Адрес компьютера представляет собой последовательность доменов, описывающих 
части адреса в текстовой форме и разделенных точкой. Например, 

metod-kopilka@mail.ru 
Для работы электронной почты созданы специальные протоколы: 

POP 3 (Post Office Protocol) – протокол почтовой службы входящих сообщений; 
SMTP (Simple Mail Transfer Protocol) – простой протокол передачи почтовых исходящих со-
общений; 
IMAP (Internet Message Access Protocol) – протокол Интернет-доступа к сообщениям. 
Для того, чтобы воспользоваться электронной почтой необходимо программное обеспече-
ние, где должны быть указаны следующие данные: логическое имя; пароль; адрес электрон-
ной почты; тип используемого протокола. 

Существует следующие способы работы с электронной почтой: 
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− с помощью клиентских программ, предназначенных для работы с электронной по-
чтой (например, Microsoft Outlook Express, которая поставляется в составе операционных 
систем линейки MS Windows на правах стандартного приложения); 

− через браузер (например, Microsoft Internet Explorer) , зарегистрировавшись на сер-
вере, который предоставляет бесплатные почтовые услуги (Web-mail). 

Обработка почтовой корреспонденции с помощью программы Microsoft Outlook Express 

1. Запустите клиентскую программу Microsoft Outlook Express с помощью 

значка  на Рабочем столе или соответствующей кнопки на Панели задач. 
2.  Выделите папку Входящие на панели Локальные папки. Область просмотра при 

этом делится на две части. Вверху отображается список сообщений электронной почты из 
текущей папки, а в нижней части окна показывается содержимое выделенного письма. По-
следовательно выделяя заголовки писем, просмотрите их содержимое. 

3. Аналогично просмотрите содержимое остальных локальных папок. 
4. В папке Входящие создайте папку Моя корреспонденция: 
− выберите пункт меню Файл - Создать - Папка; 
− в поле ввода введите имяновой папки Моя корреспонденция, проверьте правиль-

ность ее местонахождения (должна быть выделена папка Входящие) и подтвердите действия 
кнопкой ОК (или нажав Enter ). 

5. Проверьте наличие новых сообщений, воспользовавшись пунктом меню Сервис  - 
Доставить почту или соответствующей кнопкой на панели инструментов.  

6. Сохраните одно из поступивших (например, с темой «Ваше мнение?») сообщений в 
папке Моя корреспонденция: 

− выделите соответствующее сообщение; 
− указав на него, вызовите контекстное меню, нажав правую кнопку мыши; 
− укажите на папку Моя корреспонденция для сохранения в ней почтового сообще-

ния; 
− подтвердите действия клавишей ОК. 
7. Удалите одно из ненужных сообщений (по согласованию с преподавателем). 
8. Выберите пункт меню Сервис - Параметры - Подпись; 
9. Введите текст подписи (желательно с указанием электронного почтового адреса). 
10. Поставьте флажок Добавлять подпись ко всем исходящим сообщениям и снимите 

флажок Не добавлять подпись к ответам и пересылаемым сообщениям. 
11. Подтвердите действия клавишей ОК. Теперь подпись будет добавляться автомати-

чески ко всем отправляемым вами сообщениям. Убедиться в эффективности такого приема 
можно при выполнении последующих упражнений. 

12. Выберите пункт меню Сообщение - Создать или воспользуйтесь соответствующей 
кнопкой на панели инструментов; 

13.  Заполните все заголовки сообщения: Кому, Копия, Скрытая, Тема следующим об-
разом: в заголовке Кому укажите электронный адрес преподавателя, Копия – адрес соседа 
слева, Скрытая – соседа справа. В качестве Темы укажите «Анонс мероприятий». 
Примечание. Если отсутствует заголовок Скрытая, то выберите пункт меню Вид  - Все заго-
ловки. 

14. Впишите текст сообщения. 
15. Отправьте сообщение, выполнив команду меню Файл - Отправить или нажмите 

соответствующую кнопку. 
16. Подготовьте текстовый документ, содержащий приказ о награждении победителей 

районной научно-практической конференции, и сохраните его на локальном диске D :/ При-
казы - prikaz_N.doc . 

17. Используя команду меню Сообщение - Создать с использованием - Выбор бланка, 
выберите фоновый рисунок для вашего сообщения. 

18. В заголовке Кому укажите электронный адрес преподавателя, Копия – свой собст-
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венный адрес. Впишите текст сообщения. В качестве Темы укажите «Итоги конференции». 
19. В это письмо вложите для пересылки файл D:/Приказы - prikaz_N.doc. Для этого 

выполните команду меню Вставка - Вложение файла или воспользуйтесь соответствующей 
кнопкой . Укажите местонахождение файла D:/Приказы - prikaz_N.doc и дайте коман-
ду Вложить. 

20. Организуйте отправку сообщения. 
21. Убедитесь, что сообщение с вложением находится у вас и в папке Отправленные, 

и в папке Входящие (так как копию вы адресовали на свой компьютер). 
22. Перейдите в папку Входящие. Выделите сообщение с темой «Сохраните вложе-

ние!» (обратите внимание на маркировку сообщений с вложением символом «скрепка»). 
2.         Выполните команду меню Файл  - Сохранить. 

23. В открывшемся диалоговом окне выделите сохраняемое вложение. С помощью 
кнопки Обзор выберите диск и папку (например, D :/ Рабочая), где будет сохранено вложе-
ние. 

24. Отправьте преподавателю ответ с подтверждением получения вложения. Выпол-
ните команду меню Сообщение  - Ответить отправителю или воспользуйтесь соответствую-
щей кнопкой на панели инструментов. Обратите внимание, что по-
ля Кому и Тема заполняется автоматически. 

25. Впишите текст и отправьте сообщение. 
26. Проверьте результат сохранения вложения, воспользовавшись програм-

мой Проводник. 
27. Перейдите в папку Входящие. 
28. Выделите почтовое  сообщение с темой «Ознакомиться всем!». 
29. Выберите пункт меню Сообщение - Переслать (можно воспользоваться соответст-

вующей кнопкой  на панели инструментов). 
30. Заполните поле Кому, вписав адрес соседа справа, и отправьте сообщение. 
31. Пополните Адресную книгу, воспользовавшись пунктом меню Сервис - Адресная 

книга или соответствующей кнопкой  на панели инструментов. 
32. Внесите в Адресную книгу преподавателя и одного из «соседей». Для этого вы-

полните команду Файл  - Создать контакт (или щелкните левой кнопкой мыши на кноп-
ке Создать и выберите пункт меню Создать контакт). Внимательно изучите вкладки, пред-
ставленные в данном диалоговом окне. Обратите внимание на то, что в нем имеются средст-
ва для ввода как личной, так и служебной информации (для практической деятельности, как 
правило, достаточно заполнить лишь несколько полей на вкладке Имя). 

33. Начните заполнение полей вкладки Имя с поля Имя в книге. Введите сюда такую 
запись, которую хотели бы видеть в списке контактов, например Сорокин И.И.. 

34. Заполните поля Фамилия (Сорокин), Имя (Иван) и Отчество (Иванович). 
35. В поле Адреса электронной почты введите его электронный адрес, например: 

metod-kopilka@mail.ru. 
36. Занесите введенные данные в Адресную книгу, нажав на кнопку Добавить. 

Примечание . Если необходимо изменить внесенные данные, следует щелкнуть на записи 
правой кнопкой мыши, в контекстном меню выбрать пункт Свойства и перейти на вклад-
ку Имя. 

37. Откройте Адресную книгу. 
38. Выполните команду меню Файл  - Создать группу (или щелкните левой кнопкой 

мыши на кнопке Создать и выберите пункт меню Создать группу). 
39. В соответствующей форме введите Название группы (например, Коллеги). 
40. С помощью кнопки Выбрать занесите в нее из адресной книги преподавателя и 

«соседа слева». 
41. Воспользовавшись кнопкой Создать контакт, «соседа справа» одновременно зане-

сите и в Адресную книгу, и в группу. 
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42. С помощью кнопки Добавить пополните группу еще двумя записями. 
43. Подготовьте (Файл -  Cоздать сообщение) и отправьте сообщение в группу (в по-

ле Кому укажите название группы Коллеги). 
44.  Вызовите контекстное меню, щелкнув правой кнопкой мыши на свободном месте 

панели инструментов. 
45. В контекстном меню выберите пункт Настройка. 
46. Выберите Текст кнопки (например, Выводить подписи) и Размер знач-

ка (например, Мелкие значки). 
47. Из Имеющихся кнопок сформируйте Панель инструментов, используя кноп-

ки Добавить и Удалить, в следующей последовательности: Создать сообще-
ние, Ответить, Ответить всем, Переслать –Разделитель – Печать, Удалить – Разделитель –
 Доставить почту – Разделитель – Адреса. Для изменения порядка расположения кнопок ис-
пользуйте кнопки Вверх и Вниз. 

Работа с электронной почтой на почтовых WWW-серверах 

1.  Запустите программу Internet Explorer через кнопку Пуск - Программы - Internet 
Explorer или с помощью значка на Рабочем столе (Панели задач). 

2.  В адресной строке браузера введите адрес сайта www.yandex.ru. 
3.  Выберите ссылку Почта  - Зарегистрироваться или Завести почтовый ящик. 
4.    Заполните форму регистрации. 
5.  Подтвердите данные, нажав кнопку Зарегистрировать. 
6.   После успешной регистрации появляется ваш личный адрес. 
7.   Подтвердите согласие, нажав кнопку Сохранить. 
8. Откройте свой почтовый ящик.  
9. Откройте свой почтовый ящик на бесплатном почтовом сервере введя логин и па-

роль в соответствующую форму. 
10. Создайте сообщение с темой «Распоряжение»: 
− Щелкните по кнопке панели инструментов написать автору; 
− заполните заголовки сообщения: Кому, Копия, Тема следующим образом: в заго-

ловке Кому укажите адрес преподавателя, Копия – адрес «соседа слева». В качест-
ве Темы укажите «Распоряжение»; 

− впишите текст сообщения. 
11. Отправьте сообщение с помощью кнопки Отправить или воспользовавшись со-

ответствующей гиперссылкой. 
12. Перейдите в папку Входящие. Для того, чтобы прочитать полученное сообще-

ние, необходимо нажать на ссылку в поле От кого 
13. В появившемся окне нажать на кнопку Ответить  . Напишите ответ на это пись-

мо и нажмите на кнопку Отправить. 
14. Создайте новое сообщение и вложите в него файл: 
− в редакторе Microsoft Word создайте файл-проект приказа по персоналу с 

именемprikaz_N.doc и сохраните его в своем каталоге (D:\Pабочая); 
− вернитесь в свой электронный ящик; 
− щелкните по кнопке панели инструментов Написать  
− заполните заголовки сообщения: Кому, Копия, Тема следующим образом: в заго-

ловке Кому укажите адрес преподавателя, Копия – адрес «соседа справа». В качест-
ве Темы укажите«Приказ по персоналу»; 

− нажмите на кнопку Обзор, укажите местонахождение файла (D:\Рабочая\); 
− напишите текст сообщения. 
15. Отправьте сообщение, нажав на соответствующую кнопку. 
16. Перейдите в папку Входящие. В списке сообщений найдите электронное письмо 

с темой «Приказ по персоналу», отправленное «соседом слева». Значок в виде скрепки сви-
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детельствует о наличии в полученном письме вложения. Сохраните вложенный файл в пап-
ке D :\Рабочая\Ваша фамилия: 

−   откройте полученное сообщение; 
−   щелкните по значку вложенного файла левой кнопкой мыши; 
−   в появившимся окне нажмите на кнопку Сохранить; 
−   укажите путь сохранения D:\Рабочая\Ваша фамилия. 
17. Сообщение с темой «Приказ по персоналу» перешлите преподавателю. 
− откройте нужное письмо и нажмите на кнопку Переслать ; 
− заполните поле Кому, впишите электронный адрес преподавателя и отправьте со-

общение. 
Литература: 
1. Информатика: учеб.: рек. Мин. обр. РФ / под ред. Н. В. Макаровой. – М.: Финансы 

и статистика, 2000, 2005, 2001. – 268 с.   
2. Информатика. Базовый курс: учеб.: рек. Мин. обр. РФ / Ред. С.В. Симонович. – 

СПб.: Питер, 2000, 2004, 2005, 2006. – 638 с.  
3. Каймин В.А. Информатика: учеб.: рек. Мин. обр. РФ / В.А. Каймин. – 5-е изд. – М.: 

Инфра-М, 2008. – 285 с. 
Тема: Браузеры. 
План: 
1. Браузеры: основные понятия 
2. Настройка окна браузера.  
Объем аудиторных часов: 2 ч. 
Объем часов для самостоятельной работы: 10 ч. 
Указания к практической работе: 

1. Запустить Браузер Internet Explorer и познакомиться с его составом. 
1.1. Познакомиться с главным меню окна, прочитать всплывающие подсказки к пик-

тограммам, представленным на панели инструментов. 
1.2. Научиться работать с адресной строкой. 
1.2.1. Раскрыть и просмотреть список адресов. Выполнить переход на один из адре-

сов, выбранных из списка. Остановить загрузку страницы (кнопка «Стоп»). Вернуться на 

Домашнюю страницу с помощью кнопки . 
1.2.2. Научиться переключать адресную строку и строку ссылок (управлять их ото-

бражением и местоположением). 
1.3. Научиться передвигаться по гиперссылкам в текущем документе и возвращаться к 

ранее просмотренным страницам на примере сайта www.amursu.ru. 
 Возврат к просмотренным страницам выполнять как с помощью кнопок панели инст-

рументов, так и с помощью клавишных сочетаний Alt+← и Alt+→, переход по гиперссылке – 
Enter. 

1.4. Выполнить настройку размера шрифта для текстов, отображаемы в окне Браузера: 
- с помощью меню «Вид»; 
- с помощью соответствующей кнопки панели инструментов. Если такой кнопки нет, 

выполнить настройку панели. 
Последовательно установить размеры «самый крупны», «самый мелкий», «средний».  
Примечание. Если переустановки в меню не дают желаемого эффекта изменения раз-

мера шрифта, проделать этот пункт при просмотре других сайтов. 
2. Произвести настройку Браузера на быструю загрузку Web – страниц. 
2.1. Отключить отображение рисунков (меню «Сервис» - «Свойства обозревателя» - 

вкладка «Дополнительно»). 
2.2. Обновить просмотр текущей страницы. Проанализировать, как отображаются в 

Браузере места для размещения рисунков. 
2.3. Просмотреть только один из рисунков с помощью вызова контекстного меню 
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(щелкнуть по месту рисунка правой кнопкой мыши). 
2.4. Выполнить несколько переходов по гиперссылкам. 
2.5. Вернуть настройку Браузера в первоначальное положение. 
3. Научиться работать с меню «Избранное». Создавать, упорядочивать, переименовы-

вать и удалять закладки. 
В процессе выполнения работы создавать закладки на найденные Вами документы. 

Разместить их в своей папке. 
3.1. Познакомиться с меню «Избранное». Создать закладку на начальную страницу 

сайта www.amursu.ru. Убедиться, что она отображается в списке меню «Избранное». 
3.2. Создать папку для своих закладок.  
3.3. Ввести в адресное поле адрес сайта – www.rtn.ru («Российская туристическая 

сеть»). Сделать закладку на эту страницу. 
3.4. Просмотреть страницу, пролистывая её и выбирая ссылки (когда выбирается 

ссылка, адрес в адресной строке автоматически меняется на адрес ссылки). Ознакомиться с 
компонентами Web – страницы. 

Замечания. Для открытия ссылки в отдельном окне Internet Explorer нужно щелкнуть 
правой кнопкой мыши по ссылке и выбрать в контекстном меню Открыть ссылку в новом 

окне. Если адрес не загружается или загружается долго, то нажать кнопку Остановить; если 
страница загрузилась частично, нажать кнопку Обновить. 

4. Научиться настраивать Домашнюю страницу Браузера. 
4.1. Открыть меню «Сервис» - «Свойства обозревателя» - вкладка «Общие». Найти 

текстовое поле для установки адреса Начальной (Домашней) страницы. Определить, каким 
образом можно изменит этот адрес. Закрыть окно диалога. 

4.2. Перейти на Web страницу www.amursu.ru, сделать текущую страницу Домашней. 
5. Научиться работать с «Журналом» Браузера. 
5.1. Открыть для просмотра «Журнал» Браузера. Изучить критерии, по которым мож-

но выполнять сортировку записей в журнале. 
5.2. Определить, какие страницы посещались сегодня, какие – в день Вашего преды-

дущего занятия, и выполнить переход на одну из них. 
6. Научиться сохранять адреса найденных сайтов в текстовом документе. 
6.1. Открыть редактор Блокнот, вставить текущую дату и свою фамилию. Сохранить 

документ на жестком диск под именем Name_1.txt, не закрывая документ, свернуть окно в 
панель задач. 

6.2. Последовательно активизируя адреса сайтов, сохраненные в папке «Избранное», 
выполнить копирование адресов (из адресной строки Браузера) и вставить их в текстовый 
документ.  

7. Продемонстрировать преподавателю сохраненную информацию - документ 
Name_1.txt и состав Вашей папки в «Избранном». 

3. Методические указания по самостоятельной работе студентов   
 Для закрепления полученных теоретических и практических знаний студентам в те-

чение всего учебного года предлагаются индивидуальные задания для самостоятельной 
работы. Консультирование по выполнению индивидуальных заданий проводится как не-
посредственно в компьютерных классах (во время консультаций), так и через электронный 
обмен сообщениями, посредством Интернет. Защита индивидуальных заданий по темам 
может проводится в виде Круглого стола, когда каждый студент выступает с презентацией 
выполненной работы, а преподаватель вместе с остальными студентами оценивает работу. 
Задания по темам также могут быть выданы студентам в качестве домашних заданий в ви-
де электронных файлов. Контроль выполненных заданий осуществляется либо непосред-
ственно на занятиях, либо на консультациях. 

В рабочей программе п.6 представлены виды самостоятельной работы по каждой 
теме дисциплины и трудоемкость в часах. 
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Индивидуальная самостоятельная работа включает две части: текстовую (реферат), 
подготовленную с использованием текстового процессора MS Word, и электронную пре-
зентацию, выполненную средствами MS Power Point. Текстовая часть должна быть пред-
ставлена в виде твердой копии на бумажном носителе и в электронном виде (на дискете 
или СD, в формате RTF). 

Защита индивидуальных заданий будет происходить на практическом занятии в ау-
дитории. Каждое выступление должно сопровождаться презентацией. 

Примерная тематика домашних заданий 
Темы рефератов 

1. Norton Commander. Описание и возможности. 
2. Автоматизированные системы обработки информации. 
3. Архитектура персональных компьютеров. 
4. Базы данных в Internet. 
5. Внешние устройства ПК. Функциональные возможности. Основные характери-

стики.  
6. Данные и информация. 
7. Дисковая система IBM PC. 
8. Информационные технологии и их pоль в обществе. 
9. Информационное обеспечение как необходимая услуга для функционирования 

экономики в современных условиях. 
10. Информационные системы в экономике. 
11. Как появились компьютеpы. 
12. Компьютерные вирусы. 
13. Локальные и глобальные сети. Электронная почта. 
14. Многопользовательская система Windows NT. 
15. Модель файловой системы FAT. 
16. Накопители и носители информации, жесткие диски. 
17. Основные понятия мультимедиа. 
18. Персональные компьютеры в медицинской практики. 
19. Приводы CD-ROM. Форматы и стандарты. 
20. Применение компьютера в туристической деятельности. 
21. Принцип работы CD-ROM. 
22. Развитие архитектуры материнских плат для PC. 
23. Система автоматизированной обработки статистической информации. 
24. Социальная информатика. 
25. Сравнение операционных систем DOS, UNIX, OS/2, WINDOWS. 
26. Теория и практика производства накопителей на гибких магнитных дисках. 
27. Файловая система. 
28. Экспеpтные системы. Классификация экспеpтных систем. Разpаботка пpостейшей 

экспеpтной системы. 
29. Электронная почта. 
30. Проблема моделирования на ЭВМ основных функций человеческого мышления. 
31. Информационный маркетинг в Интернете. 
32. Общая характеристика преступлений в сфере компьютерной информации. 
33. Компьютерные преступления. 
34. Компьютерная преступность и компьютерная безопасность. 
35. Современные банковские автоматизированные системы. 
36. Компьютерные технологии в строительстве. 
37. Информационная безопасность. 
38. Технологии создания сетей ЭВМ. 
39. DVD-ROM устройство и принцип работы. 
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40. Электронная коммерция. 
41. Экспертные системы. 
42. Экономическая информатика. 
43. Цифровая подпись. 
44. Технология World Wide Web. 
45. Теория фреймов. 
46. Теория и практика производства накопителей на гибких магнитных дисках. 
47. Телекоммуникационные средства в современном компьютерном мире. 
48. Современные текстовые редакторы. 
49. Сетевые операционные системы. 
50. Нейрокомпьютерные системы. 
51. Накопитель на гибких магнитных дисках. 
52. Накопители на жестких магнитных дисках. 
53. Модемы и коммуникационные протоколы. 
54. Криптографические методы защиты информации. 
55. Классификация текстовых процессоров. 
56. Классификация табличных процессоров. 
57. Классификация систем параллельной обработки данных. 
58. Информационные технологии в управлении. 
59. Интерактивные графические системы. 
60. Интеллектуальные и экспертные системы. 

Требования к оформлению реферата 
1. Поля страницы: слева – 3, сверху и снизу – 2, справа – 1. 
2. Размер шрифта – 14. 
3. Межстрочный интервал – 1,5. 
4. Шрифт – Times New Roman. 
5. Нумерация страниц – внизу, по центру. 
6. В конце – список использованной литературы. 
7. Объем реферата – не менее 15 листов. 
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IV. КОНТРОЛЬ ЗНАНИЙ 

В течении семестра знания студентов оцениваются с использованием рейтинговой 
системы, которая складывается из оценки за работу в семестре – максимально 60 баллов и 
экзаменационной (зачетной) оценки – максимально 40 баллов. Максимально возможное ко-
личество равно 100. Баллы по разным модулям приведены в рабочей программе п.12. 

Минимальное количество баллов в семестре, необходимое для получения студентом 
допуска на зачет, равно 40 баллов. 

Минимальное количество баллов за выполнение экзаменационной (зачетной) работы, 
необходимое для получения оценки: «удовлетворительно» -  15 баллов, «хорошо» - 20 бал-
лов, «отлично» - 30 баллов. 

Соответствие итогового рейтинга студента и традиционных оценок устанавливается 
по следующей шкале: «неудовлетворительно» - 0-50 баллов, «удовлетворительно» - 51-75 
баллов, «хорошо» - 76-90 баллов, «отлично» - 91-100 баллов. 

В качестве основных средств текущего контроля используется тестирование. В каче-
стве дополнительной формы текущего контроля предлагаются аудиторные и внеаудиторные 
письменные задания (контрольные работы). 

1. Текущий контроль знаний 
1. Табличный процессор Word 

1. Команды открытия и сохранения файла находятся в пункте меню: 
a) Файл; b) Правка; c) Формат. 

2. Колонтитул – это: 
a) граница текста; 
b) строки текста, печатаемые на всех полях страницы; 
c) строки текста, печатаемые на верхних и нижних полях страницы. 

3. Для организации таблицы следует выполнить команду ... и указать число строк, 
столбцов: 

a) Вставка → Таблица; 
b) Таблица → Нарисовать; 
c) Таблица → Добавить. 

4. Для обозначения конца абзаца используется клавиша: 
a) Enter; b) Shift+Enter; c) Ctrl+Enter. 

5. Поместить в документ рисунок можно при помощи пункта меню: 
a)  Вид; b)  Сервис; c)  Вставка. 

6. Какая команда помещает выделенный фрагмент текста в буфер обмена без удале-
ния: 

a) Копировать; b) Вырезать; c) Вставить. 
7. С помощью какого элемента можно вставить объект WordArt: 

a) 1; 
b) 2; 
c) 3; 
d) 4. 

8. Копирование выделенного абзаца выполняется так: 
a) Правка→ Копировать; 
b) Формат→Абзац→Копировать; 
c) Абзац→Копировать. 

9. Заменить одно слово на другое можно командой: 
a) Сервис → Правописание → Заменить; 
b) Правка → Правописание → Заменить; 
c) Правка → Заменить. 
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10. Для ввода степени числа используют: 
a) шрифт маленького размера; 
b) вставку специального символа; 
c) верхний индекс. 

2. Электронная таблица Excel 

1. Для задания диапазона ячеек Excel, два требуемых адреса необходимо разделить: 
a) двоеточием; b) тире; c) точкой с запятой.

2. Запись «B$1» означает, что при копировании ячейки Excel: 
a) изменится имя столбца; 
b) изменится номер строки; 
c) изменятся имя и номер ячейки. 

3. Изменяющийся при копировании и перемещении адрес ячеек Excel: 
a) ссылка; 
b) абсолютная ссылка; 
c) относительная ссылка. 

4. Содержимым отдельной ячейки может быть: 
a) график, диаграмма или рисунок; 
b) число, текст, или формула; 
c) команда, файл, каталог. 

5. Для задания диапазона ячеек нужно указать: 
a) его левый верхний и правый нижний адреса ячеек; 
b) адрес каждой ячейки диапазона; 
c) адреса двух ячеек с максимальным и минимальным элементами. 

6. Укажите правильную запись формулы, вычисляющей произведение содержимого 
ячеек А1 и В1: 

a) С1=А1*В1; b) А1*В1; c) = А1*В1. 
7. Если в клетках ЭТ содержится формула, то при обычном режиме в данной клетке 

отображается: 
a) содержимое данной клетки; 
b) математическая функции; 
c) вычисленное по этой формуле значение. 

8. Для указания абсолютного адреса используется знак: 
a) #; b) %; c) $. 

9. Файл, в котором хранится таблица Excel, имеет расширение: 
a) .doc; b) .exe; c) .xls. 

10. Результатом вычислений в ячейке С1 будет: 
a) 5; 
b) 10; 
c) 15. 

 А В С 
1 5 = А1*2  =СУММ(А1:В1)   

3. Электронные презентации PowerPoint 

1. В каком режиме просматривается данная презентация?  
a) обычный; 
b) страницы заметок; 
c) сортировщик слайдов. 

2. Как изменить междустрочный интервал в маркированном списке?  
a) Формат → Абзац; 
b) Формат → Список; 
c) Формат → Интервалы. 

3. На картинке изображен слайд с таблицей. Вставить подобную таблицу в слайд воз-
можно с помощью 

a) Вставка → Таблица; 
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b) Формат → Таблица; 
c) Вид → Таблица. 

4. На рисунке изображена рамка с текстом, выровненным определенным образом. 
Укажите номер кнопки, соответствующей данному типу выравнивания: 

a) 1; 
b) 2; 
c) 3. 

5. В процессе демонстрации презентации докладчик может использовать инструмент 
Карандаш. На рисунке представлен пример применения этого инструмента. Укажите пункт 
контекстного меню, соответствующий выбору инструмента Карандаш: 

a) записная книжка; 
b) заметки докладчика; 
c) указатель. 

6. На рисунках изображен слайд с одинаковым содержимым. Чем различаются эти 
слайды? 

   
a) шаблонами оформления; 
b) цветовыми схемами; 
c) эффектами анимации. 

 7. На рисунке представлена картинка из коллекции MS Office ClipArt. Укажите все 
способы вставки картинок из данной коллекции: 

a) Вставка → Рисунок → Картинки; 
b) Вставка → Рисунок → Автофигуры; 
c) Вид → Вставка → Вставка картинки. 

8. На картинке изображено окно Настройки анимации. Меню «Вход» (выделено крас-
ным) устанавливает эффект анимации: 

a) для всего слайда при смене слайдов;  
b) для выделенного на слайде объекта; 
c) для всех слайдов создаваемой презентации. 

4. Компьютерные сети. Интернет 

1. Компьютерная сеть – это: 
a) группа установленных рядом вычислительных машин, объединенных с помо-

щью средств сопряжения и выполняющих единый информационно-вычислительный про-
цесс; 

b) совокупность компьютеров и терминалов, соединенных с помощью каналов связи 
в единую систему, удовлетворяющую требованиям распределенной  обработки данных; 

c) совокупность сервера и рабочих станций, соединенных с помощью коаксиального 
или оптоволоконного кабеля. 

2. Информационно-вычислительные системы по их размерам подразделяются на: 
a) локальные, региональные, глобальные, широкомасштабные; 
b) терминальные, административные, смешанные; 
c) цифровые, коммерческие, корпоративные. 

3.  Локальная вычислительная сеть – это: 
a) вычислительная сеть, функционирующая в пределах подразделения или подразде-

лений предприятия; 
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b) объединение вычислительных сетей на государственном уровне; 
c) общепланетное объединение сетей. 

4. Признак «Топология сети» характеризует: 
a) схему приводных соединений в сети (сервера и рабочих станций); 
b) как работает сеть; 
c) состав технических средств. 

5.  Локальные вычислительные сети по признаку «топология» подразделяются на: 
a) реальные, искусственные; 
b) типа «Звезда», «Шина», «Кольцо»; 
c) проводные, беспроводные. 

6. Программное обеспечение локальной вычислительной сети включает: 
a) сетевую операционную систему, пакеты прикладных программ, базы данных; 
b) пакеты прикладных программ, базы данных; 
c) MS-Dos, MS-Windows, NetWare. 

7. Наиболее распространенной операционной системой для локальной вычислитель-
ной сети является: 

a) Unix; b) MS-DOS; c) Windows. 
8. Сервер – это: 

a) персональный компьютер, подключенный к сети, через который пользователь 
получает доступ к ее ресурсам; 

b) компьютер, подключенный к сети и обеспечивающий ее пользователей опре-
деленными услугами; 

c) два или более абонентов вычислительной сети, соединенных каналом связи. 
9. Рабочая станция – это: 

a) персональный компьютер, подключенный к сети и выполняющий модуляцию и 
демодуляцию информации; 

b) персональный компьютер, подключенный к сети, через который пользователь 
получает доступ к ее ресурсам; 

c) устройство, выполняющее функции сопряжения ЭВМ с каналом связи. 
10. Шлюз – это: 

a) устройство, позволяющее организовать обмен данными между двумя сетями, 
использующими один и тот же протокол взаимодействия; 

b) устройство, позволяющее организовать обмен данными между двумя сетями, 
использующими различные протоколы взаимодействия; 

устройство, соединяющее сети разного типа, но использующее одну операционную 
систему. 

2. Итоговый контроль знаний. 
В рабочей программе п.9 представлены вопросы к зачету и варианты зачетных тесто-

вых заданий. 
 

 
V. ИНТЕРАКТИВНЫЕ ТЕХНОЛОГИИ И ИННОВАЦИОННЫЕ МЕТОДЫ, ИС-

ПОЛЬЗУЕМЫЕ В ОБРАЗОВАТЕЛЬНОМ ПРОЦЕССЕ. 
Образовательный процесс по дисциплине строится на основе комбинации следующих 

образовательных технологий.  
Интегральную модель образовательного процесса по дисциплине формируют техно-

логии методологического уровня: модульно-рейтинговое обучение, технология поэтапного 
формирования умственных действий, технология развивающего обучения, элементы техно-
логии развития критического мышления. 

Рекомендуется использование информационных технологий при организации комму-
никации со студентами для представления информации, выдачи рекомендаций и консульти-
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рования по оперативным вопросам (электронная почта), использование мультмедиа-средств 
при проведении лекционных и лабораторных занятий. 

Игровые имитационные методы: 
Мозговой штурм – наиболее свободная форма дискуссии, позволяющей быстро включить в 

работу всех членов учебной группы. Используется там, где требуется генерация разнообразных идей, 
их отбор и критическая оценка. Этапы продуцирования идей и их анализа намеренно разделены: во 
время выдвижения идей запрещается их критика.. Тема: «Теория вероятностей» (2 часа). 

Круглый стол – это метод активного обучения, одна из организационных форм позна-
вательной деятельности учащихся, позволяющая закрепить полученные ранее знания, вос-
полнить недостающую информацию, сформировать умения решать проблемы, укрепить по-
зиции, научить культуре ведения дискуссии.  

Дискуссия – это всестороннее обсуждение спорного вопроса в публичном собрании, в 
частной беседе, споре.  

Деловая игра – форма воссоздания предметного и социального содержания профес-
сиональной деятельности, моделирования систем отношений, разнообразных условий про-
фессиональной деятельности, характерных для данного вида практики.  

Метод анализа конкретной ситуации (ситуационный анализ, анализ конкретных си-
туаций, case-study) – это педагогическая технология, основанная на моделировании ситуации 
или использования реальной ситуации в целях анализа данного случая, выявления проблем, 
поиска альтернативных решений и принятия оптимального решения проблем. 

Мастер-класс – это главное средство передачи концептуальной новой идеи своей (ав-
торской) педагогической системы. Преподаватель как профессионал на протяжении ряда лет 
вырабатывает индивидуальную (авторскую) методическую систему, включающую целепола-
гание, проектирование, использование последовательности ряда известных дидактических и 
воспитательных методик, занятий, мероприятий, собственные «ноу-хау», учитывает реаль-
ные условия работы с различными категориями учащихся и т.п. 


